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Foreword 

Thank you very much for choosing and using the 6419 distributed optical fiber strain tester produced by China 

Electronics Instrument Co., Ltd. The company produces high-grade, high-precision and advanced products, with 

the highest quality cost-effectiveness among similar products. We always comply with the ISO9000 standard 

during the production process, and we’re customer-oriented and consider the quality as the enterprise's life. Please 

read this manual carefully for your convenience. We will make our best efforts to meet your needs, provide you 

with the most cost-effective control equipment, and bring you first-class after-sales service. With the consistent 

purpose of "good quality, considerate service", it’s our commitment to provide satisfactory products and services 

to you. We sincerely hope to bring convenience and speed to your work, and welcome your inquiries through calls: 

Website: www.ceyear.com 

E-mail: sales@ceyear.com 

Address: No. 98, Xiangjiang Road, Qingdao City, China 

Postal code: 266555 

This manual describes the purpose, performance characteristics, basic principles, application methods, 

maintenance, and precautions of the 6419 distributed optical fiber strain tester to help you become familiar with 

and master the operating methods and key points of the controller. In order to make better use of this product and 

create more economic benefits for you, please read this manual carefully. 

Due to the tight time and the limited capability of the author, it is inevitable that there are errors and omissions in 

this manual, please criticize and correct! We apologize for the inconvenience caused by the mistakes we made. 

 

Statement: 

This manual is the third edition of the user manual of 6419 distributed optical fiber 

strain tester, the version number is D.2. 

The contents of this manual are subject to change without notice. The right of 

interpretation to the contents and the terms used in the manual belongs to China 

Electronics Technology Instruments Co., Ltd. 

The copyright of this manual belongs to China Electronics Technology Instruments 

Co., Ltd. Any unit or individual may not modify or tamper with the contents of this 

manual without the authorization of China Electronics Technology Instruments Co., 

Ltd, and may not copy or distribute this manual for the purpose of profit. China 

Electronics Technology Instruments Co., Ltd reserves the right to pursue legal 

liability for any violation. 
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Safety requirements 

The following general safety precautions must be taken at any stage of operating the instrument. Failure to take 

these safety precautions or to follow the warnings and precautions described elsewhere in this manual will violate 

the safety standards for the design, manufacture, and use of the instrument. China Electronics Technology 

Instruments Co., Ltd assumes no responsibility for the consequences arising from users’ violation of these 

requirements. 

Use environment 

For the working environment and storage environment of this instrument, please refer to the description of the 

technical parameters in Chapter XI. 

Power supply 

For the requirements of the working power of this instrument, please refer to the description of the technical 

parameters in Chapter XI. The working power of this instrument must range from 198Vac to 242Vac. Be sure to 

use the dedicated three-wire power cord shipped with the instrument or the three-wire power cord of the regular 

manufacturer's specifications, and ensure that the grounding is good, so as to avoid inducting voltage generated by 

the enclosure. The fuse of the same specification shall be used when replacing the fuse in the fuse holder. 

Do not use the instrument in an explosive or flammable environment 

Do not use the instrument in the presence of flammable gases or fumes. 

Do not disassemble any parts of the instrument 

Do not disassemble any parts of the instrument except those that are authorized to be replaced by the users. 

Replacement of parts and internal adjustments can only be carried out by the maintenance personnel authorized by 

or entrusted by China Electronics Technology Instruments Co., Ltd. 

Safety terms used in this manual 

: Remind users to pay attention to a process, operation method, or similar situation. Failure to 

operate properly or in accordance with the rules may result in personal injury or damage to the 

instrument. 

: Remind users to pay attention to a process, operation method, or similar situation. Failure to 

operate properly or in accordance with the rules may result in partial or whole damage to the 

instrument. 

: Information that aids in the use and maintenance of the instrument. 

 

Warning! 

Caution! 

Note! 
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Warnings for the use of instrument 

Requirements for power supply 

: The power supply used in this instrument must meet the following requirements: 220VAC ± 

10%, 1.5A, 50 ~ 60Hz. Using a power supply that is too high/low or unstable will cause damage 

to the instrument. Using a power supply that is too high/low or unstable will cause damage to 

the instrument. 

Laser safety 

The safety standards for the lasers used in this instrument are in accordance with IEC65 and IEC348. 

Although the output intensity of the laser used in this instrument is within the safety standard, it 

may damage the visual acuity, so the output of the laser should be prevented from directly 

shooting into the eye. Do not look directly into the light output connector of the instrument with 

your eyes, and do not look directly at the end of the fiber during testing. When the VFL function 

of the instrument is turned on, do not look directly at the VFL's output port or the end of the 

fiber connected to the VFL output port. 

Use of distributed optical fiber strain tester (BOTDR) 

(1) It is absolutely not allowed to connect an optical fiber with any optical signal to the test port 

of the 6419 distributed optical fiber strain tester. This may result in inaccurate measurement 

results and even permanent damage to the instrument. Please ensure that all fibers tested by this 

instrument are in a no-signal state. 

(2) It is absolutely not allowed to connect and disconnect the optical fiber during the test of the 

6419 distributed optical fiber strain tester. This will cause the instantaneous increase of echo of 

the optical fiber tested by the instrument, which may cause permanent damage to the instrument. 

(3) It is absolutely not allowed to connect the fiber interface that does not match the optical 

interface of the 6419 distributed optical fiber strain tester to the test port of the 6419 distributed 

optical fiber strain tester. This will not only increase the insertion loss due to the mismatched 

optical interface and result in no inaccurate test results, but will also cause permanent damage to 

the optical interface. 

Transportation and packaging 

(1) Please pack the 6419 distributed optical fiber strain tester with the original standard 

aluminum alloy box during transportation, and ensure that the 6419 distributed optical fiber 

strain tester does not move in the aluminum alloy box. Special note: When placing the 

instrument in an aluminum alloy box, no filler is allowed in front of the LCD display to 

avoid damage to the LCD display during transportation. 

(2) Care should be taken during transportation to avoid damage to the 6419 distributed optical 

fiber strain tester caused by severe shock and vibration. 

Warning! 

Warning! 

Warning! 

Warning! 
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Notes for the use of instrument 

LCD display 

(1) Do not use a sharp object to click on the LCD screen, and do not impact the LCD screen 

with big power. This will damage the LCD screen. 

(2) Do not drop or splash organic solvents or contaminants on the LCD screen, such as acetone, 

oil, antifreeze, grease, etc., otherwise the LCD screen will not work properly. 

(3) Wipe the LCD screen with silk cloth or soft fabric. Do not wipe the LCD screen with organic 

solvent, otherwise, this may damage the LCD screen. 

Use of distributed optical fiber strain tester (BOTDR) 

(1) The light output connector of the instrument has a delicate and fragile ceramic positioning 

core inside. When the fiber is connected, be sure to insert the fiber plug in parallel and screw it 

tightly after aligning the positioning pin. 

(2) When using this instrument for measurement, the inside of the light output connector of the 

instrument and the end face of the light output connector of the instrument must be kept clean to 

prevent the grease and other contaminants from contaminating the light output connector. 

Otherwise, it will cause measurement error of the instrument, and may cause the instrument not 

be able to test the fiber. 

(3) If possible, when testing the instrument, point the end of the fiber under test to a non-

reflective object. 

Maintenance and service 

(1) Please use the original packaging materials when carrying the instrument to avoid severe 

shock and vibration. 

(2) The instrument should be stored under the ambient temperature range between 0°C and 50°C, 

and it should be kept ventilated and dried without direct sunlight. 

(3) When storing the instrument, the dust cover on each optical port of the instrument should be 

covered. 

 

Caution! 

Caution! 

Note! 
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Calibration requirements 

The validity of the technical parameters is related to the operating environment of the instrument. The duration of 

the calibration can be extended or shortened depending on the use intensity, the operating environment and the 

maintenance of the instrument. You should determine the appropriate calibration period based on your needs. 

In the case of normal use of the instrument, it is recommended that the 6419 distributed optical fiber strain tester 

be calibrated once a year. For details, please call the service number. 

Warranty and repair of instrument 

(1) The warranty period of the whole machine (except for the light output connector and 

consumables) is 18 months. Items offered during product promotions are not within the scope of 

the warranty. 

(2) The light output connector and optical fiber output contact of the instrument are consumables, 

which are not within the scope of the warranty. 

(3) Damage or deterioration of the instrument due to irresistible force and human factors is 

within the scope of the warranty. 

(4) The instrument shall be maintained by China Electronics Technology Instruments Co., Ltd or 

its designated authorized maintenance unit. It is illegal for any other unit or individual to 

disassemble and repair the instrument. The instrument will lose its warranty qualification and 

the China Electronics Technology Instruments Co., Ltd reserves the right to pursue legal 

liability for violators. 

 (5) The instrument will lose its warranty qualification once it is dismantled and disassembled in 

an unauthorized manner. The instrument will lose its warranty qualification once the fastening 

screws or sealing strip is removed. 

Description: 

China Electronics Technology Instruments Co., Ltd reserves the right to make any changes to the design and 

structure of the 6419 distributed optical fiber strain tester at any time, but has no obligation or responsibility to 

freely modify or replace the products sold for free. Accessories of this product, including but not limited to fiber 

end face tester, optical fiber patch cords and mice, are not subject to the warranty of this manual. 

When the instrument needs to be returned for repaired, calibration or maintenance, the following 

points shall be noted: 

(1) If the test data is stored in the instrument, please back up the data to avoid loss. 

(2) Please use the original packaging box for packaging and transportation. 

(3) If other packaging box is used, please make sure there is at least soft filler of 3 cm around 

the instrument. 

(4) To reduce the impact of external forces. 

(5) Please indicate the contact address, contact number, description of the situation, etc. when 

the instrument is returned. 

(6) Please seal the packaging box with tape before shipping. 

(7) Damage caused by improper packaging is not within the scope of the warranty when the 

instrument is returned. 

 

Caution! 

Note! 
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Chapter I Overview 

1 Overview of instrument 

The 6419 distributed optical fiber strain tester (hereinafter referred to as 6419 BOTDR can test the strain 

distribution, loss distribution and Brillouin scattering spectrum of fiber optic cable simultaneously. It can 

simultaneously display the 3D and multiple distribution parameters, and has the advantages of high strain test 

accuracy, good repeatability and single-ended non-destructive testing, which is an indispensable test instrument in 

the field of Optical Fiber Communications and Optical Fiber Sensing. 

The product can be widely used in the development, production and testing, construction and acceptance of fiber 

optic gyro, fiber optic hydrophone and submarine cable, and line maintenance and support. 

The product can also be widely used in the detection of health status of bridges, dams, tunnels, tall buildings, oil 

rigs, oil pipelines, etc., as well as the prediction of geological disasters such as landslides, debris flows and 

earthquakes. It also has important applications in the detection of intelligent structural health status of large-scale 

marine vessels and aerospace vehicles. 

The main functions and features of the instrument are as follows: 

1. Brillouin scattering distribution test function 

2. Distributed optical fiber strain test function 

3. Distributed optical fiber loss test function 

4. Distributed Brillouin scattering spectrum width  test function    

5. Multiwindow display function 

6. File management function 

7. Remote control function 

8. Timing test and data saving functions 

9. 3D display function of loss distribution 

10. Test curve comparison function 

11. Large screen color LCD display, touch screen operation 

12. Built-in VFL (visual fault location) function 

13. Upgrade of application software system without need to return to the original factory 
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2 Components of instrument 

2.1 Basic components 

The basic components of the 6419 BOTDR are shown in Table 1-1. 

Table 1-1 Basic components of 6419 BOTDR 

ITEM Name Qty 

Host 6419 distributed optical fiber strain tester 1 

Standard accessories 

Power cord 1 

User Manual 1 

CD or USB 1 

Aluminum alloy box 1 

Standard edition of 6419 data analysis software 1 

2.2 Optional components 

Table 1-2 6419 List of optional components of BOTDR 

Serial number Name Qty 

001 Fiber end face tester 1 

002 Advanced lens paper 1 

003 Optic optical fiber patch cord (FC/APC to FC/UPC) 1 

004 Professional edition of 6419 data analysis software 1 

005 SC fiber optic adapter 1 

006 FC fiber optic adapter 1 

3. Description of instrument panel 

3.1 View of instrument front panel 

 

（1）

（2） （3） （4） （5）（6）（8）（7）

（9）

（10）

（12） （11）

 

Figure 1-1 Schematic diagram of the front panel of the instrument 
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Table 1-3 Descriptions of the functions of each part of the front panel 

No. Name Function description Remarks 

(1) Power indicator 

When the power is off, the indicator is off; when the power is on 

but the instrument is not turned on, the indicator is orange; when 

the instrument is turned on, the indicator is green. 

 

(2) On/Off button Used to turn the instrument on and off.  

(3) USB interface 
Used to connect USB devices such as USB keyboard, USB mouse 

and USB flash drive. 
 

(4) Touch LCD screen 
Used to display measurement information and perform touch 

screen operation. 
 

(5) Navigation button 

Including arrow keys and cursor keys, used to scale the test curve 

in the test state and move the cursor during test conditions and 

system settings. 

Detailed in Section 

3.1.1 

(6) VFL optical interface FC/APC interface.  

(7) 
BOTDR optical 

interface 
FC/APC interface.  

(8) Laser indicator Used to indicate whether the laser inside the instrument is running.  

(9) Numeric key area 

Used to enter or modify the number, “.” and “-” characters in the 

input box of the cursor in the test condition, file operation or 

system setting interface. 

 

(10) Knob keypad Used to move the cursor for the test curve. 
Detailed in Section 

3.1.2 

(11) Function keypad 
Including 8 common function keys, which can directly and quickly 

perform the functions corresponding to the function keys 

Detailed in Section 

3.1.3 

(12) Menu button 

The nine menu buttons correspond to the nine function menus in 

the software interface, and the corresponding menu functions can 

be executed by pressing the buttons. 

Detailed in Section 

3.1.4 

3.1.1 Description of navigation button functions 

(1) In the test state, the test curve in the window is scaled around the position of the curve where the cursor is 

located: 

 and are used to expand and compress the vertical coordinate of the test curve in the window display 

area respectively. This function is invalid in the "multiwindow" state; 

 and are used to expand and compress the horizontal coordinate of the test curve with the distance as 

the abscissa in the window display area respectively. This function is invalid in the "Brillouin spectrum" state; in 

the "multiwindow" state, the cursor in the multiwindow sub-menu is set as the "distance/frequency", and the two 

buttons are used for synchronous expansion and compression of the horizontal coordinates corresponding to the 

curves of the strain distribution, the distribution of Brillouin scattering spectrum width, and the loss distribution, 

respectively. 

(2) In the test condition and system setting interface, the cursor button  [Cursor] is used to move the cursor in 

different parameter setting boxes, if the cursor moves to the drop-down menu,  and  are used to 

display the previous item of the current menu option; and  and  are used to display the next item of 

current menu options. If the cursor is in the radio button or progress bar,  and  are used to control the 

single option or the progress bar to move forward, and  and  then control the single option or 

progress bar to move backward. 

3.1.2 Description of knob keypad functions 

Knob: It’s used to move the cursor on the test curve in the window display area. When the knob rotates clockwise, 

the cursor on the test curve moves right; when the knob rotates counterclockwise, the cursor on the test curve 

moves left. 
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Coar.Coar.
:  Coar.
Coar.

 button is used to switch between the normal movement mode and the fast movement mode of the 

knob. If the knob is in the normal movement mode, the distance the cursor moves each time is 1 unit horizontal 

coordinate; if the knob is in the fast movement mode, the distance each time the cursor moves is 10 unit horizontal 

coordinates. 

3.1.3 Description of function keypad functions 

TestTest
: Perform/stop the average processing test. When the instrument is performing an average processing test, 

using this button will stop the average processing test; when the instrument is in the non-average processing test 

state, using the test button will start the averaging processing test. 

VFLVFL : Pop-up VFL control dialog box, providing fault location function of visual cable for users to select among 

four VFL working states of OFF, CW, 1Hz and 2Hz. 

SetupSetup
: Press this button to enter the test condition setting interface (this button is invalid when system setting or 

file operation is in progress). 

FileFile : Press this button to enter the file operation sub-menu (this button is invalid when the test condition setting 

or system setting is in progress). 

Dist.Dist.
: Switch the corresponding mode of the current horizontal cursor to the distance mode. 

Freq.Freq.
: Switch the corresponding mode of the current horizontal cursor to the frequency mode. 

StrainStrain
: Switch the current window to the "strain distribution" state automatically, showing only the "strain 

distribution" window. 

LossLoss
: Switch the current window to the "comprehensive loss" state automatically, showing only the 

"comprehensive loss" window. 

3.1.4 Description of menu button functions 

The menu button corresponds to the function menu button on the right side of the 6419 BOTDR software interface. 

If you want to execute the menu item of the function menu being displayed on the software interface, just press 

the menu button of its corresponding position. 

3.2 View of instrument back panel 

 

Figure 1-2 Schematic diagram of the back panel of the instrument 

(1) LAN interface (2) VGA interface (3) RS232 interface (4) USB interface (5) Headphone jack (6) Power 

interface (7) Power switch. The description of corresponding functions of each part of 6419 BOTDR back panel 

are shown in Table 1-4 (The picture is for reference only, the actual products shall prevail). 

Table 1-4 Descriptions of the functions of each part of the back panel 

No. Name Function description Remarks 

(1) LAN interface 
A network cable can be used to connect the instrument to the network or 

directly to other computers. 
 

(2) VGA interface The VGA cable can be used to connect the instrument to external display.  

(3) RS232 interface 
The RS232 serial cable can be used to communicate with other computers or 

serial devices. 
 

 

（1） （2） （3） （4） （5）（6） （7）
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(4) USB interface 
Used to connect USB devices such as USB keyboard, USB mouse, and USB 

flash drive. 
 

(5) Headphone jack Used to connect to headphones.  

(6) Power switch Used to turn the power of the instrument on/off.  

(7) Power interface Used to connect the power cord. Power cord  
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Chapter II Description of Operation Interface 

1 Main operation interface 

The main operation interface of the 6419 BOTDR is shown in Figure 2-1. 

（1）

（2） （3） （4）

（5）

（6）

 

Figure 2-1 Schematic diagram of the main operation interface 

The operation interface of 6419 BOTDR instrument is divided into six areas: (1) Test result area, (2) Test 

condition area, (3) Waveform operation area, (4) Sub-waveform window, (5) Function menu area and (6) Window 

display area, the specific information is described as below. 

1.1 Test result area 

This area is used to display some results of the 6419 BOTDR test, which has the following meanings: 

FWHM: Indicates the Brillouin spectrum bandwidth of the current distance point; 

fB: Indicates the center frequency of the Brillouin spectrum fitting curve of the current distance; 

Peak: Indicates the peak relative power of the Brillouin spectrum at the current distance point. 

1.2 Test condition area 

This area is used to display the test conditions or Marker information of the instrument. When the software is in 

the Marker sub-menu, the Marker information will be displayed in this area. In other cases, the test condition of 

the instrument will always be displayed in the area. See Section 2 in Chapter 3 for details. 

1.3 Waveform operation area 

The waveform operation area includes   buttons, with the following functions: 

 and : In the "strain distribution" state, the "spectral width distribution" state, the "loss distribution" state, 

and the "comprehensive loss" state, it’s used to compress or expand the horizontal coordinate of the test curve 

with the cursor as the center in the window display area. When the [cursor] in the in the multiwindow sub-menu is 

set as the "distance/frequency", the two buttons are used for synchronous expansion and compression of the 

horizontal coordinates corresponding to the strain distribution, the spectral width distribution, and the loss 

distribution curves, respectively. 

 and : It’s used to expand and compress the vertical coordinate of the test curve with the cursor as the 

center in the window display area respectively. This function is invalid in the "multiwindow" state; 

 and : It’s used to control the cursor to move left or right on the measurement curve of the window display 

area, moving 1 horizontal unit at a time. 

 and : It’s used to control the cursor to move left or right quickly on the measurement curve of the window 

display area, moving 10 horizontal units at a time. 

The [Cursor] button setting in the function menu determines whether the horizontal coordinate controlled by the 

waveform operation button control is the distance or frequency mode, and other corresponding operations will be 

triggered according to the operation for the selected horizontal coordinates (for details, see "Chapter IV 
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“Description of Window Display”) . 

1.4 Sub-waveform window 

When the window display area is in the "strain distribution" state, the "spectral width distribution" state, the "loss 

distribution" state, and the "comprehensive loss" state, the sub-waveform window displays the Brillouin spectrum 

curve on the cursor of the global curve or curve of the measurement curve according to the setting of the 

[Sub.Wave] function button in the main function menu. 

The sub-waveform window in the Brillouin spectrum state is displayed as a strain distribution global curve. 

1.5 Function menu area 

This area is used to display the function menu of the software. Each function menu button has a one-to-one 

correspondence with the menu buttons on the front panel of the instrument. The corresponding function menu 

buttons can be selected by pressing the front panel menu button of the instrument to realize the functions, or the 

corresponding functions can be performed by clicking the function menu buttons with the mouse or through the 

touch screen. 

1.6 Window display area 

In the "multiwindow" state, "strain distribution" state, "spectral width distribution" state, "Brillouin spectrum" 

state, "loss distribution" state, "comprehensive loss" state, and "3D" state, this area is used to display the 

measurement curve in the corresponding state; the corresponding setting interface is displayed when setting the 

test condition, file operation and system. 

2 Structure and function of main menu 

The function menu displayed by default in the main operation window after the instrument is turned on is the 

main function menu, including [Real-time Test], [Average], [Test condition], [3D display], [Multiwindow], [File], 

[System] and [Sub.Wave]. 

[Real-time Test]: The instrument starts/stops testing the real-time loss distribution curve at the selected sweep 

frequency. The real-time test allows the sweep frequency of the test to be changed at any time during the test, 

which is convenient for quickly determining the optimal start frequency condition for the average processing test. 

This function does not stop automatically after execution. If the real-time test is not stopped, the test will continue 

until the instrument is turned off. Figure 2-2 shows the loss distribution curve under real-time test. The knob 

button on the front panel of the instrument is used to change the sweep frequency of the real-time test. 

 

Figure 2-2 Loss distribution curve under real-time test 

[Average]: The instrument starts/stops the average processing test function to test the loss distribution curve of the 

fiber under test. The average processing test function calculates the strain distribution curve of the fiber under test 

by testing the loss distribution curve at the sweep frequency point from the start frequency to the cut-off frequency, 

so the function will automatically stop after the test is completed after execution. Figure 2-3 shows the loss 

distribution curve under the average processing. 
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Figure 2-3 Loss distribution curve under average processing 

[Test condition]: After entering the test condition setting interface shown in Figure 2-4, the measurement 

conditions and parameters related to the 6419 BOTDR measurement process can be set, and the function menu 

area will display the test condition sub-menu (for details, see "Chapter III Description of Test Conditions"). 

 

Figure 2-4 Interface of test condition 

[3D display]: The window display area will enter the “3D” status interface shown in Figure 2-5. Only the “3D” 

window will be displayed. The function menu area will display the sub-menu in the 3D state (for details, see 

“Chapter V Description of 3D Display Functions”). 

 

Figure 2-5 Interface of 3D state 

[Multiwindow]: The window display area will enter the "multiwindow" state shown in Figure 2-6, and the "strain 

distribution" window, the "spectral width distribution" window, the "Brillouin spectrum" window, and the "loss 

distribution" window will be displayed. The function menu area will display the sub-menu in the multiwindow 

state (for details, see "Chapter IV Description of Window Display"). 
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Figure 2-6 Interface of multiwindow state 

[File]: After entering the file operation interface, the function menu area will display the file sub-menu to can 

open the file, save the file and open the reference file, as shown in Figure 2-7 (for details, see "Chapter VI 

Description of File Functions"). 

 

Figure 2-7 Interface of opening file 

[System]: The function menu area will display the system sub-menu (as shown in Figure 2-8). The 6419 BOTDR 

system function can be used and set according to the menu function provided (for details, see “Chapter VII 

Description of System Menu”). 

 

Figure 2-8 Function menu area showing the system sub-menu 

[Sub.Wave]: It is used to set the display contents in the sub-waveform window (as shown in Figure 2-9). If the 

button is displayed as “global Brillouin spectrum”, it indicates that the sub-waveform window will display the 

global test curve; if the button is displayed as “global Brillouin spectrum”, it indicates that the sub-waveform 

window will display the spectrum curve at the distance point where the cursor is located. In the “Brillouin 
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spectrum” state, the sub-waveform window only displays the global strain curve (for details, see “Chapter IV, 

Section 2, Description of Sub-waveform Window”. 

 

Figure 2-9 Sub-waveform window 
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Chapter III Description of Test Conditions 

Press the [Test condition] button to enter the test condition setting interface. As shown in Figure 3-1, the window 

display area displays the test condition setting interface, and the function menu area displays the test condition 

sub-menu. 

 

Figure 3-1 Test condition setting interface 

1 Description of test condition sub-menu 

The test condition sub-menu is shown in Figure 3-1 and has the following functions: 

[Move Up]: Move the focus to the parameter box directly right above the parameter box where the current focus is 

located. If the current focus is already at the top, move to the parameter box at the bottom of the other side. 

[Move Down]: Move the focus to the parameter box directly right below the parameter box where the current 

focus is located. If the current focus is already at the bottom, move to the parameter box at the top of the other 

side. 

[Move Left]: Move the focus to the parameter box on the left of the parameter box where the current focus is 

located. 

[Move Right]: Move the focus to the parameter box on the right of the parameter box where the current focus is 

located. 

[Drop Down]: If the parameter box where the current focus is located is a drop-down box, a drop-down list will 

pop up. 

[Page Up]: Display the test condition setting interface of the previous page. 

[Page Down]: Display the test condition setting interface of the next page. 

[Enter]: Save the current test condition parameters and return to the main operation interface. 

[Back]: Don’t save users’ modification to the current test condition parameters and return to the main operation 

interface. 

2 Description of test condition parameters 

2.1 Range 

The range parameter is used to set the distance range of the scanning curve of the instrument. The user can set an 

integer from 0.5 to 127km with double-click of the input box. If the decimal is entered, it will be rounded up by 

default, as shown in Figure 3-2. 

The parameter should be set according to the length of the fiber to be tested. The test range value shall not be 

lower than the length of the fiber to be tested to avoid the secondary reflection of the fiber end affecting the test 

result. The length of the fiber can be given either by the fiber/cable manufacturer or measured by the OTDR or the 

instrument. 
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Figure 3-2 Range setting interface 

2.2 Pulse width 

The instrument can be set to 10, 20...200ns with an increment of 10ns, there are 20 pulse widths to choose from, 

which can be selected by touch screen or mouse, or can be selected by “↑” or “↓” on the navigation keys. As 

shown in Figure 3-3. 

The pulse width parameter determines the spatial resolution of the test, and its correspondence relation is shown in 

Table 3-1. In general, the wider the pulse width, the longer the detection distance and the higher the strain test 

accuracy, but the lower the spatial resolution, in the actual test, the pulse width should be properly selected 

according to the test requirements. 

Table 3-1 Correspondence relation between pulse width and spatial resolution 

Pulse 

width 

Spatial 

resolution 

Pulse 

width 

Spatial 

resolution 

Pulse 

width 

Spatial 

resolution 

Pulse 

width 

Spatial 

resolution 

10ns 1m 60ns 6m 110ns 11m 160ns 16m 

20ns 2m 70ns 7m 120ns 12m 170ns 17m 

30ns 3m 80ns 8m 130ns 13m 180ns 18m 

40ns 4m 90ns 9m 140ns 14m 190ns 19m 

50ns 5m 100ns 10m 150ns 15m 200ns 20m 

 

Figure 3-3 Pulse width setting interface 

2.3 Average times 

It is used to set the average times when the instrument is sampling, with a value of 2
n
, n is the selected parameter 

value, and the average times is 2
10

 to 2
24

, and there are fifteen optional values. According to the test time and test 

results, comprehensive consideration can be made to set the appropriate average times. 

Increasing the average times can improve the signal-to-noise ratio and improve the strain test, but it will increase 

the test time. For double increase in the average times, the test time will also be doubled. When the average times 
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is increased to a certain extent, the effect of suppressing noise will no longer be obvious, and the test time will 

increase greatly, so the average times should not be too large. The default value of the instrument is 2
14

. 

 

Figure 3-4 Setting interface of average times 

2.4 Resolution 

It is used to set the sampling resolution of the instrument, also called the sampling interval. There are various 

resolutions to choose, from 0.05m, 0.1m, 0.2m, 0.5m, 1m to 2m (as shown in Figure 3-5), the lower the sampling 

resolution value (the higher the corresponding resolution or the smaller the sampling interval), the higher the 

distance measurement accuracy of the instrument, the finer distribution of fiber strain along the distances can be 

detected, but test time will extend accordingly. 

In actual use, due to the limitation of the maximum number of sampling points of the instrument (currently, the 

maximum number of sampling points is 80,000 points), different sampling resolutions are selected, and the range 

of the fiber strain curve that can be detected and displayed is different. The calculation method is: The product of 

80,000 and sampling resolution corresponds to the maximum distance of the strain distribution of the displayable 

fiber. For example, if the selected resolution is 0.05m, the maximum distance of the fiber strain distribution that 

the instrument can display is 4km at the highest 80,000 sampling point; if the resolution is chosen to be 0.5m, the 

longest distance of the fiber strain distribution that the instrument can display is 40km theoretically. Therefore, if a 

longer distance sensing fiber is tested, but a higher resolution is chosen, the instrument can only display the strain 

distribution curve of a certain distance in the fiber, because the product of the highest sampling point and the 

selected resolution is less than the length of the fiber (see “Setting of Starting Point”). If it’s hoped to display the 

complete strain distribution of the fiber, it’s necessary to reduce the resolution so that the product is larger than the 

length of the fiber. 

 

Figure 3-5 Resolution setting interface 
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Table 3-2 Relationship between sampling resolution and maximum test length 

Resolution (m) Maximum test length (km) 

0.05m 4 

0.1 8 

0.2 16 

0.5 40 

1 80 

2 128 (maximum range) 

It should be pointed out that the singular point measured in the case of high sampling resolution can be presented 

in the partial display, but may not be presented in the global display due to the screen resolution. The singular 

point can be presented in the display of 6419 BOTDR. 

2.5 Refractive index 

It is used to set the refractive index of the fiber under test. The setting of the refractive index will directly affect 

the distance of the instrument test fiber. In general, it can be set to 1.468. As shown in Figure 3-6, the refractive 

index can be input in the input box, or input with the soft keyboard by double-clicking the input box. 

 

Figure 3-6 Setting interface of refractive index 

2.6 Starting point 

The starting point parameter is used to set the starting distance of the instrument to test the measured fiber, and the 

setting range is from 0 to the selected range. The user can set the parameters to observe the details of the fiber 

strain distribution after the test of the starting point. The setting interface of starting point is shown in Figure 3-7. 

The default value is 0. 

The significance of this parameter is that high-resolution testing can be performed on any segment of the fiber 

under test to observe the details of the distribution of the strain along the distance of any segment of the fiber. It 

should be noted that it is valid and meaningful to set the starting point parameter only when the product of the 

maximum number of sampling points and the resolution is greater than the test range. For example, for a 70km 

sensing fiber, if you want to observe the complete strain distribution of a 70km fiber, the resolution must be 

greater than 0.5m, because 80,000 (maximum sampling points) × 0.5m (resolution) = 40km, when the starting 

point is 0, it can only observe the fiber strain distribution in the range of 40km. However, the starting point can be 

set to 40km at this time, so that the strain distribution of the latter segment of the fiber can be observed. 
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Figure 3-7 Setting interface of starting point 

2.7 Output optical power 

The input box of output optical power is shown in Figure 3-8. There are four optional values of relatively low, low, 

medium and high. It’s used to set the intensity of the optical pulse signal used in the instrument test, and the 

increase of the output optical power can improve the quality of the test signal and the accuracy of the instrument 

when the optical fiber under test is long or the test signal is poor. 

 

Figure 3-8 Setting of the output optical power 

2.8 Start frequency 

The Start frequency refers to the Start frequency of the scan. As shown in Figure 3-9, the Start frequency can be 

entered through the numeric keys of front panel or the digital screen keyboard after double-clicking the input box. 

The setting value cannot be higher than the ending frequency. The Start frequency should not be set to too small 

value, otherwise the scanning frequency points will be increased, and the test time will be extended; and the 

setting value should not be set to too large value, otherwise, the complete Brillouin spectrum cannot be obtained, 

and the strain of the optical fiber cannot be tested. 

The setting of the Start frequency is directly related to the budget value (fy) of the minimum strain of the fiber. 

Generally, a trial Start frequency can be set first. Then the strain distribution of the fiber can be tested to observe 

whether there is a jump change of zero strain point in the small strain distribution along the fiber. If there is a zero 

strain point, the Start frequency is set too large, and it can be appropriately reduced. The frequency of the starting 

point should be offset from the center frequency with no less than 100MHz. In general, the starting scanning 

frequency set should be less than 100MHz above the center frequency of the Brillouin spectrum in order to be 

able to obtain a complete Brillouin scattering spectrum and facilitate curve fitting. Table 3-4 shows the 

recommended values for the starting scanning frequency setting. Assuming that the fiber fB(0) is 10.64GHz, the 

test pulse width is 20ns, and it is expected to withstand an axial compressive strain of 1,000με, the Start frequency 

should be set to fB(0) - 0.1 - 1,000/20,000 = 10.49GHz. 
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Table 3-4 Correspondence relation between the recommended value of the Start frequency and the pulse width 

Pulse width (ns) Recommended value of the Start frequency (GHz) 

10 fB(0)-0.2-fy/20000 

20 B(0)-0.1-fy/20000 

50 B(0)-0.05-fy/20000 

100 B(0)-0.05-fy/20000 

200 B(0)-0.05-fy/20000 

 

Figure 3-9 Setting of the Start frequency 

2.9 Ending frequency 

The ending frequency refers to the ending frequency of the scan. As shown in Figure 3-10, the ending frequency 

can be entered through the numeric keys of front panel or the digital screen keyboard after double-clicking the 

input box. The setting value cannot be higher than the Start frequency. The ending frequency should not be set to 

too large value, otherwise the scanning frequency points will be increased, and the test time will be extended; and 

the setting value should not be set to too small value, otherwise, the complete Brillouin spectrum cannot be 

obtained, and the strain of the optical fiber cannot be tested. 

The setting of the ending frequency is directly related to the budget value (fy) of the maximum strain of the fiber. 

Generally, a trial ending frequency can be set first. Then the strain distribution of the fiber can be tested to observe 

whether there is a jump change of zero strain point in the large strain distribution along the fiber. If there is a zero 

strain point, the ending frequency is set too small, and it can be appropriately increased. The frequency of the 

starting point should be offset from the center frequency with no less than 100MHz. In general, the ending 

scanning frequency set should be less than 100 MHz above the center frequency of the Brillouin spectrum in order 

to be able to obtain a complete Brillouin scattering spectrum and facilitate curve fitting. Table 3-5 shows the 

recommended value set for the ending scanning frequency. Assuming that the fiber fB(0) is 10.64GHz, the test 

pulse width is 20ns, and it is expected to withstand an axial compressive strain of 5,000 με, the ending frequency 

should be set to fB(0) + 0.1 + 5,000/20,000=11.04GHz. 

Table 3-5 Correspondence relation between the recommended value of the ending frequency and the pulse width 

Pulse width (ns) Recommended value of the ending frequency (GHz) 

10 fB(0) + 0.2 + fy/20,000 

20 fB(0) + 0.1 + fy/20,000 

50 fB(0) + 0.5 + fy/20,000 

100 fB(0) + 0.5 + fy/20,000 

200 fB(0) + 0.5 + fy/20,000 
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Figure 3-10 Setting of the ending frequency 

2.10 Frequency interval 

The frequency interval is the step value of the scanning frequency change, as shown in Figure 3-11. Users can 

choose 1MHz, 2MHz, 5MHz, 10MHz, 20MHz and 50MHz frequency interval through the touch screen or double-

click of the mouse, or the “↑” or “↓” of the navigation keys after clicking the setting item area. The frequency 

interval, the Start frequency and the ending frequency determine the number of sweep points tested together. The 

formula is: 

The number of frequency scanning points = (ending frequency - start frequency) / frequency interval 

The maximum number of frequency scanning points of the instrument is 500. The smaller the frequency interval, 

the more the number of sweep points, and the longer the test time. It is generally recommended to set it to 

5MHz or 10MHz. 

 

Figure 3-11 Setting interface of frequency interval 

2.11 fB (0) 

This parameter is the center frequency of the Brillouin scattering spectrum of the fiber under test without strain. It 

is related to the material of the fiber and is one of the important parameters for calculating the strain distribution 

of the fiber. If absolute strain test is required, the parameter needs to be calibrated (It needs to be obtained by 

means of a specific device), otherwise, only relative testing can be performed. The specific test methods are as 

follows: 

Step 1: Connect the fiber under test without strain to the BOTDR optical interface of front panel, and test the 

strain curve according to the method described in Chapter VIII, Section 2.1. Click [Multiwindow] → [Strain Dis.] 

to enter the strain distribution window. 

Step 2: Click [Marker] to enter the marker function menu. Use the touch screen or waveform operation button to 

move the cursor to the vicinity of 10% of the length of the fiber under test. Click [Marker 1] to set the marker 

point 1; move the cursor to the vicinity of 90% of the length of the fiber under test, click [Marker 2] to set the 

marker point 2; 

Step 3: Click [Strain Frequency] to switch the marked calculation data in the test condition area to frequency data, 
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then the average center frequency value displayed in the Ave item is the initial frequency shift of Brillouin 

spectrum fB (0) of this segment of fiber, as shown in Figure 3-12. 

fB(0)

M1 M2

 

Figure 3-12 Initial frequency shift of Brillouin spectrum fB (0) test 

By setting marker 1 and marker 2, the maximum value, minimum value, average value 

and standard deviation of the fiber strain (or frequency) between the two markers can be 

automatically calculated, and the strain and Brillouin center frequency can be converted. 

For detailed operation, see the description of the function of the marker points in Chapter 

IV, Section 1.1.3. 

Through the above test, fB (0) can be input through the numeric keys of front panel or the digital screen keyboard 

pop up after double-clicking the input box, as shown in Figure 3-13. 

 

Figure 3-13 fB (0) setting interface 

2.12 CS 

The parameter is the strain coefficient of the fiber, that is, the relationship between the strain of the fiber and the 

center frequency of the Brillouin spectrum. Like the Start frequency shift parameter of the fiber, this parameter is 

one of the important parameters for calculating the strain distribution of the fiber, and is related to the fiber 

material. If an absolute strain test is required, the parameter needs to be calibrated (it needs to be obtained by 

means of a specific device), otherwise, only relative testing can be performed. As shown in Figure 3-14, the CS 

parameter can be entered through the numeric keys of front panel or the digital screen keyboard after double-

clicking the input box. The default value is 0.05MHz/με. 

Note! 
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Figure 3-14 CS. setting interface 

2.13 Continuous test 

The continuous setting parameter is used to set the timing test of the instrument and opening and closure of 

automatic saving function. 

The continuous test is in the "off" state by default in the system as shown in Figure 3-15. Continuous test can be 

enabled by selecting “enable” from the continuous test drop-down menu, and continuous test options will appear 

in the test condition setting interface: Time interval, Autosave options, as shown in Figure 3-16. 

When the continuous test option is enabled, the instrument will time and test according to the time interval 

settings until the user stops the average processing test. 

 

Figure 3-15 Disable the test condition setting interface of continuous test 

 

Figure 3-16 Enable the test condition setting interface of continuous test 

2.14 Time interval 
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The time interval is used to set the time interval between two start-up tests in minutes. If the time interval set 

value is less than the single test time, the instrument will test at the minimum time interval of a single test. 

2.15 Autosave 

Auto saving sets the auto saving function of measurement data through the drop-down menu, it is in “OFF” sate 

by default. When auto saving is set to OFF, the instrument will not save the data automatically in the continuous 

test state, and the current measurement result will only be displayed in the window display area. When auto saving 

is set to ON, the test condition setting interface increases the File Type, File No. and SavePath options, as shown 

in Figure 3-17. 

 

Figure 3-17 Enable the test condition setting interface of auto saving 

2.16 File serial number 

The file serial number is the file name when the data file name is automatically saved, which can be entered 

through the mouse or the soft keyboard pop out after double-clicking the text box on the touch screen, or the 

numeric key area of the front panel of the instrument, as shown in Figure 3-18. After enabling the auto saving, the 

data file will be automatically stored in the selected path in the form of "file serial number _XXXX. file type" 

once the test is completed. XXXX is the file order saved after starting continuous test, if the file serial number is 

set to 1602251025, the file type is sta file, then the first saved file name is: 1602251025_0000.sta, the second 

saved file name is: 1602251025_0001.sta, and the third saved file name is 1602251025_0002.sta, ……, and so on. 

 

Figure 3-18 File serial number setting and soft keyboard interface 

2.17 File type 

The file type is used to set the type of the file saved automatically. The drop-down menu has two data types 

"*.sta" and "*.eis" to choose from, and the "*.sta" type data stores all measurement results of the instrument, 

"*.eis" type data only contains data of strain. For the description about the type of the 6419 distributed optical 

fiber strain tester, see Chapter VI, Section 4. 

2.18 Autosave path 

The autosave path display is located directly below the file serial number, as shown in Figure 3-19. The path 

button is used to set the save path of the data during continuous test. It is located on the right side of the file serial 

number input box. After clicking the path button with the touch screen or mouse, the sub-window of path setting 
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will be displayed in the test condition area at the lower left of the screen. 

In the sub-window of path setting, the partition and directory of file saving can be set by mouse or touch screen. 

 

Figure 3-19 Save path setting interface 

3 Description on operation of test condition interface 

The parameter boxes in the 6419 BOTDR test condition interface are divided into two categories. One is the input 

box that can be freely input by the user; the other is the drop-down box where the user can only select the 

parameter among the given parameters. 

3.1 Description of operation of input box 

The parameter boxes of the refractive index, test starting point, Start frequency, ending frequency, fB(0) and CS 

under the test condition interface are input boxes. The user can change the parameter values in the input box by 

operation on touch screen, mouse or front panel keys. 

(1) Use the touch screen or mouse to change the parameters in the input box. The steps are as follows: 

① Use the touch screen or left mouse button to click the input box that needs to change the parameters, and move 

the focus to the corresponding parameter input box; 

② Double-click the input box to pop out the numeric keypad as shown in Figure 3-20; 

③ Click the clear key, number key and decimal point in the numeric keypad to change the value in the box. The “-

>” and “<-” keys can control the cursor in the parameter box to move forward or backward character by character; 

④ Click the "OK" button to complete the input of the parameter values. 

 

Figure 3-20 Schematic diagram of numeric keypad 

(2) Use the buttons on the front panel to change the parameters in the input box. The steps are as follows: 

① Use the buttons on the menu keypad of front panel to run [Move Up], [Move Down], [Move Left] and [Move 

Right] in the function menu. The cursor buttons on the navigation keypad can also be used to move the focus of 

the test condition interface to the input box that needs to change the parameters; 

② Enter the parameters using the numeric keys in the numeric key area and delete the parameters using the 

backspace key; 

③ Use the Enter key to confirm the entered parameters or use the ESC key to cancel the modification of the 

parameters in the selected parameter box. 

3.2 Description of operation of drop-down box 

The parameter boxes such as range, pulse width, average times, sampling resolution, output optical power, 

automatic scanning, and frequency interval under the test condition interface are drop-down boxes. 

(1) Use the touch screen or mouse to change the parameters in the drop-down box. The steps are as follows: 
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① Use the touch screen or left mouse button to click the part of the drop-down box that needs to change the 

parameters, and pop out the list; 

② Select the desired parameter value to complete the input. 

(2) Use the buttons on the front panel to change the parameters in the drop-down box. The steps are as follows: 

① Use the function keys of [Move Up], [Move Down], [Move Left] and [Move Right] in the function menu. The 

cursor buttons on the navigation keypad can also be used to move the focus of the test condition setting interface 

to the drop-down box that needs to change the parameters; 

② Use the [Drop Down] function key in the function menu to pop out the list of selected drop-down boxes; 

③ Use the arrow button on the navigation keypad of front panel to move the focus in the drop-down list and move 

the focus to the parameter you want to select; 

④ If you did not perform step ② and step ③, the arrow button  or  can select the previous option of 

currently displayed menu item in the drop-down menu option,  or  can select the next option of the 

currently displayed menu item. Then use the function keys of [Move Up], [Move Down], [Move Left] and [Move 

Right] in the function menu, or the cursor buttons on the navigation keypad to move the focus of the test condition 

setting interface to the parameter boxes of other parameters to complete the input in the drop-down box. 
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Chapter IV Description of Window Display 

1. Description of the state of window display area 

There are seven states in the 6419 BOTDR window display area, which are “multiwindow” state, “strain 

distribution” state, “spectral width distribution” state, “Brillouin spectrum” state, “loss distribution” state, 

“comprehensive loss” state and, "3D" state. 

1.1 Multiwindow state 

 

Figure 4-1 Multiwindow state 

1.1.1 Overview 

The “multiwindow” state is the default state of window display area of the instrument software. When the 

instrument software is started, the window display area will automatically enter the “multiwindow” state; the user 

returns to the multiwindow sub-menu from the tertiary menu under the multiwindow sub-menu and returns to the 

main menu from the secondary menu, the window display area will automatically enter the "multiwindow" state. 

In the "multiwindow" state, the window display area will display the "strain distribution" window, the "spectral 

width distribution" window, the "Brillouin spectrum" window, and the "loss distribution" window. The upper right 

corner of the window display area displays the state as "multiple-window", the window display area is shown in 

Figure 4-1. 

In the "multiwindow" state, the "strain distribution" window, the "spectral width distribution" window, the 

"Brillouin spectrum" window, and the "loss distribution" window will all display curves according to the test 

results in the instrument, if the window has no corresponding data to display, this window will be empty and the 

curve will not be displayed. 

1.1.2 Description of sub-menu 

Click the [Multiwindow] function button in the main function menu to enter the multiwindow sub-menu. The 

multiwindow sub-menu is a secondary menu. The structure is shown in Figure 4-2. The function of the menu 

button is as follows: 

[Strain Dis.]: The function menu area displays the sub-menu of strain distribution, and the window display area 

enters the “strain distribution” state. 

[Spectral width distribution]: The function menu area displays the sub-menu of spectral width distribution, and the 

window display area enters the "spectral width distribution" state. 

[Brillouin spectrum]: The function menu area displays the sub-menu of Brillouin spectrum, and the window 

display area enters the "Brillouin spectrum" state. 

[Loss Dis.]: The function menu area displays the sub-menu of loss distribution, and the window display area 

enters the “loss distribution” state. 

[Comprehensive Loss]: The function menu area displays the sub-menu of comprehensive loss, and the window 

display area enters the “comprehensive loss” state. 

[Cursor]: It is used to select distance mode or the frequency mode of cursor movement in the "multiwindow" state. 

[Global Display]: It initializes the curves of all windows in the "multiwindow" state, and returns to the initial state 
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of the test so that each window can display the full view of the curve. 

[Back]: Return to the main function menu, and the status of the window display area remains in the 

"multiwindow" state. 

 

Figure 4-2 "Multiwindow" sub-menu 

1.1.3 Description of operation 

In the "multiwindow" state, the curves displayed in the "strain distribution" window, the "spectral width 

distribution" window, the "loss distribution" window, and the "Brillouin spectrum" window can be operated 

through the touch screen, the mouse, and the front panel keys, but the result of the operation will change due to 

the setting of the [Cursor] function button in the multiwindow sub-menu. 

(1) In the "multiwindow" state, after setting the [Cursor] function button in multiwindow sub-menu to 

"distance/frequency", the cursor can be moved or the curve can be scaled in the "strain distribution" window, the 

"spectral width distribution" window, and the "loss distribution" window. 

① The curves displayed in the “strain distribution” window, the “spectral width distribution” window, and the 

“loss distribution” window can be compressed along the horizontal coordinate after clicking  the button in the 

waveform operation area through the left mouse button or the touch screen. The curves displayed in the “strain 

distribution” window, the “spectral width distribution” window, and the “loss distribution” window can be 

expanded along the horizontal coordinate after clicking the  button in the waveform operation area through the 

left mouse button or the touch screen. The curves displayed in the “strain distribution” window, the “spectral 

width distribution” window, and the “loss distribution” window can be compressed along the vertical coordinate 

after clicking the  button in the waveform operation area through the left mouse button or the touch screen. 

The curves displayed in the “strain distribution” window, the “spectral width distribution” window, and the “loss 

distribution” window can be expanded along the vertical coordinate after clicking the  button in the waveform 

operation area through the left mouse button or the touch screen. The cursor moves in the above window through 

clicking the  buttons. The  button indicate fast movement. The  button moves the cursor 

to the left by ten units at a time. The  button moves the cursor to the right by ten units at a time.  

indicate normal movement, and the  button moves the cursor to the left by one unit at a time, the  button 

moves the cursor to the right by one unit at a time. 

② The navigation buttons on the front panel can be used to scale the horizontal coordinate. 

The  button on the navigation keypad of front panel can be used to compress the curves displayed in the 

“strain distribution” window, the “spectral width distribution” window, and the “loss distribution” window along 

the horizontal coordinate; 

The  button on the navigation keypad of front panel can be used to expand the curves displayed in the 

“strain distribution” window, the “spectral width distribution” window, and the “loss distribution” window along 

the horizontal coordinate; 

③ The knob buttons on the navigation keypad of front panel can be used to move the cursor in the “strain 

distribution” window, the “spectral width distribution window, and the loss distribution window. Rotate the cursor 
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clockwise to the right and counterclockwise to the left. Click the "fast" button on the front panel, the movement 

speed of mobile knob will be ten times faster, click the "fast" button again to return to the original speed. 

Moving the position of the cursor in the “strain distribution” window, the “spectral width 

distribution” window, and the “loss distribution” window will change the selected distance 

point of the Brillouin spectrum curve displayed in the “Brillouin spectrum” window, so the 

“Brillouin spectrum” window will be changed to display the Brillouin spectrum curve 

corresponding to the new selected distance point. 

(2) In the "multiwindow" state, after setting the [Cursor] function button in multiwindow sub-menu to 

"distance/frequency", the cursor can be moved or the curve can be scaled in the "Brillouin spectrum" window. 

① In the “multiwindow” state, the curve displayed in the “Brillouin spectrum” window can be operated through 

clicking the  buttons in the waveform operation area through the left mouse button or touch screen. 

 indicate fast movement, and the  button moves the cursor to the left by ten units at a time, the  

button moves the cursor to the right by ten units at a time.  indicate normal movement, and the  button 

moves the cursor to the left by one unit at a time, the  button moves the cursor to the right by one unit at a time. 

 ②The knob buttons on the navigation keypad of front panel can be used to move the cursor in the “Brillouin 

spectrum” window. Rotate the cursor clockwise to the right and counterclockwise to the left. Click the [Quick] 

button on the front panel, the movement speed of mobile knob will be ten times faster, click the [Quick] button 

again to return to the original speed. 

Moving the position of cursor in the Brillouin Spectrum window will change the sweep 

frequency point displayed in the loss distribution curve in the “loss distribution” window, 

so the “loss distribution” window will be changed to display the corresponding loss 

distribution curve of new sweep frequency point. 

1.2 Strain distribution window 

 

Figure 4 -3 Display window of “strain distribution” state window 

1.2.1 Overview 

Click [Multiwindow] → [Strain Dis.], or click the [Strain] button on the function keypad of front panel to enter the 

display interface of strain distribution. The upper right corner of the window display area displays the state as 

“strain distribution”, and the function menu area displays the sub-menu of strain distribution, and the window 

display area is as shown in Figure 4-3. The "strain distribution" state is used to display the strain-distribution 

curve of the fiber under test. 

The sub-waveform window in Figure 4-3 displays the Brillouin spectrum line, because the [Sub.Wave] in the 

main function menu is selected as the "global Brillouin spectrum" state. If the [Sub.Wave] is selected as "global 

Brillouin spectrum", then the sub-waveform displays the global curve of the strain distribution. 

The “strain distribution” window displays the strain-distance curve, which is used to represent the strain values at 

different distances on the fiber under test. The strain size at different distances of the fiber under test can be 

observed visually by observing this window. 

Note! 

Note! 



Chapter IV Description of Window Display 

30 

The vertical line in the window of Figure 4-3 is the cursor, the “0.37423km” below the horizontal axis is the 

distance value of the position where the cursor is located, and “2,656.8με” is the strain value of the position where 

the cursor is located (με is the strain unit, the size is equivalent to the 10
-6

 of the total length, that is, one in a 

million). 

1.2.2 Description of sub-menu 

Click the [Strain Dis.] function button in the multiwindow sub-menu, and the function distribution area will 

display the strain distribution sub-menu. The structure of strain distribution sub-menu is shown in the function 

menu area in Figure 4-3. The functions are as follows: 

[fB (0)]: Used to set the parameters required for the instrument to calculate the strain distribution—the initial 

frequency shift fB (0), fB (0) is the frequency shift of Brillouin spectrum of the fiber without strain, namely, the 

initial frequency shift of Brillouin spectrum. 

[C.S.]: Used to set the parameters required for the instrument to calculate the strain distribution - strain coefficient, 

Cs. Cs is the strain coefficient of the frequency shift of Brillouin spectrum of fiber, which is a constant related to 

the fiber material and the wavelength of the probe light. For the conventional G.652 single mode fiber, the strain 

coefficient Cs is generally approximate to 493MHz/% or 0.0493MHz/με at the detection wavelength of 1,550nm. 

[Marker]: The function menu area will display the sub-menu of Marker for setting the marker points in the “strain 

distribution” window, and the test condition area will be changed to display the marker point information. 

[Difference]: Display the difference between the current data and the reference data in the window. 

[Clear Ref.]: Clear all the maker points in the “strain distribution” window. 

[Global Display]: Restore the zoom state of the strain distribution window to the initial state. 

[Exchange Reference]: Exchange the current display curve with the reference curve, switch the current display 

curve to the reference curve, and switch the reference curve to the current display curve. 

[Clear reference]: Clear the reference curve displayed in the software. 

[Back]: Return to the multiwindow sub-menu, the function menu area will display the multiwindow sub-menu. 

After changing fB (0) or Cs., the instrument will recalculate the currently displayed test 

curve according to the new parameter value and refresh the test curve after calculation. 

1.2.3 Description of operation 

(1) Cursor movement and coordinate scaling 

① In "strain distribution" state, the curve displayed in the window can be zoomed out by clicking the 

 button in the waveform operation area through the left mouse button or the touch screen; the curve will shrink 

along the horizontal direction by pressing the  button, the curve will enlarge along the horizontal direction by 

pressing the  button, the curve will enlarge along the vertical direction by pressing the  button, the button 

curve will shrink along the vertical direction by pressing the  button; the movement of the cursor can be moved 

by clicking the  button,  indicate fast movement, and the  button moves the cursor to the 

left by ten units at a time, the  button moves the cursor to the right by ten units at a time.  indicate 

normal movement, and the  button moves the cursor to the left by one unit at a time, the  button moves the 

cursor to the right by one unit at a time. 

② In the "strain distribution" state, the arrow direction in the navigation keypad of front panel can be used to scale 

the curve displayed in the window. 

③ The knob buttons on the navigation keypad of front panel can be used to move the cursor in the “strain 

distribution” window. Rotate the cursor clockwise to the right and counterclockwise to the left. Click the [Quick] 

button on the front panel, the movement speed of mobile knob will be ten times faster, click the [Quick] button 

again to return to the original speed. 

(2) Operation of maker points of Marker 

The maker point of Marker can be set and cleared in the "strain distribution" state. Reasonable setting of makers 

points and viewing of Marker information can help users reduce the amount of data recording and the amount of 

Note! 
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data calculation. 

① Placement of Marker points 

In the "strain distribution" state, the Marker sub-menu can be entered by clicking the [Marker] function button 

under the strain distribution sub-menu through the mouse, touch screen or menu buttons of front panel. At this 

time, the test condition area displays the Marker information, as shown in Figure 4- 4. 

 

Figure 4-4 Marker interface in the "strain distribution" state 

The maker points of Marker should be placed in the order of Marker 1 to Marker 4. The 

inversion of sequential order will coincide with the Marker points. In this case, the position 

of Marker points can be adjusted in order to make them display normally. 

② Description of Marker information 

[Strain Frequency]: It is used to switch the Marker information type displayed in the test information area. If this 

button is [Strain Frequency], then the test condition area will display the strain information of the marker area of 

Marker; if this button is [Strain Frequency], then the test condition area will display the Brillouin center 

frequency information of the marker area of Marker. 

In the “strain distribution” state, there are two groups of marker information of Marker, namely “Marker1-2” 

group and “Marker3-4” group. 

1) When [Strain Frequency] is set to "strain". 

All information below the "Marker1-2" position belongs to the "Marker1-2" group, and the meaning of the data 

information is as follows. 

Distance: It indicates the difference in distance between marker point 1 and marker point 2, the unit is km, mi. or 

kft. 

Strain: It indicates the difference between the strain at the maker point 1 and the strain at the maker point 2, the 

unit is % or με. 

Max: It indicates the maximum strain value of the fiber segment between the marker point 1 and the marker point 

2, the unit is % or με. 

Min: It indicates the minimum strain value of the fiber segment between the marker point 1 and the marker point 

2, the unit is % or με. 

Ave: It indicates the average strain value of the fiber segment between the marker point 1 and the marker point 2, 

the unit is % or με. 

Std: It indicates the standard deviation of the strain of the fiber segment between the marker point 1 and the 

marker point 2, the unit is % or με. 

All information below the "Marker3-4" position belongs to the "Marker3-4" group, and its data information 

corresponds to the distance (distance), the strain difference (strain), the maximum strain value (Max), the 

minimum strain value (Min), the average strain value (Ave) and the strain standard deviation (Std) between the 

marker point 3 and the marker point 4. 

2) When [Strain Frequency] is set to "Frequency". 

Note! 
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All information below the "Marker1-2" position belongs to the "Marker1-2" group, and the meaning of the data 

information is as follows. 

Distance: It indicates the difference in distance between marker point 1 and marker point 2, the unit is km, mi. or 

kft. 

Frequency: It indicates the difference between the strain at the marker point 1 and the Brillouin center frequency 

at marker point 2, the unit is GHz. 

Max: It indicates the maximum Brillouin center frequency of the fiber segment between marker point 1 and 

marker point 2, the unit is GHz. 

Min: It indicates the minimum Brillouin center frequency of the fiber segment between marker point 1 and 

marker point 2, the unit is GHz. 

Ave: It indicates the average Brillouin center frequency of the fiber segment between marker point 1 and marker 

point 2, the unit is GHz. 

Std: Indicates the difference standard deviation of the Brillouin center frequency of the fiber segment between the 

marker point 1 and the marker point 2, the unit is GHz. 

All information below the "Marker3-4" position belongs to the "Marker3-4" group, and its data information 

corresponds to the distance (distance), the Brillouin center frequency difference (frequency), the maximum 

Brillouin center frequency (Max), the minimum Brillouin center frequency (Min), the average Brillouin center 

frequency (Ave) and the difference standard deviation of Brillouin center frequency(Std). 

③ Clearance of Marker points 

In the sub-menu of strain distribution, use the left mouse button, touch screen or menu button of front panel to 

click the [Clear marker] function button under the sub-menu of strain distribution to clear all the maker points set 

in the "strain distribution" state. 

The position of set Maker points is temporarily saved in the "strain distribution" state, but 

if the user switches from the "strain distribution" state to the "spectral width 

distribution" state, the "loss distribution" state, the "comprehensive loss" state" and the 

“Brillouin spectrum” state, the position of set Maker points that has been temporarily 

saved in the "strain distribution" state will be cleared, so if the maker point is used in the 

next test, please save it in time. 

(3) Operation of difference analysis 

When the system runs the test data and loads the reference data, as shown in Figure 4-5, select the [Difference] 

button in the sub-menu of strain distribution, and the strain distribution state is displayed for the difference 

function. 

 

Figure 4-5 Difference interface in the "strain distribution" state 

① Changes of strain distribution window 

As shown in Figure 4-6, after selecting the difference function, the strain distribution window is divided into 

upper and lower parts. The upper part shows the strain curve of test data and the reference data. The horizontal 

coordinate shows the distance of the current cursor position, 4.28858km, and the strain value of the two sets of 

Note! 



Chapter IV Description of Window Display 

33 

data of corresponding distance point. The strain value of measured data at the cursor is 3,902.6με, and the strain 

value of the reference data is 3,842.0με; the lower part shows the difference curve between the test data and the 

reference data, and the horizontal coordinate shows the distance of the current cursor position, 4.28858km and the 

difference between the two strains is 60.6με. 

 

Figure 4-6 Difference state interface of strain sub-menu 

The reference data is loaded using [Open Ref.] in the [File] sub-menu of the main function 

menu. 

② Changes of strain distribution menu 

After selecting the difference function, the [Difference] in the original strain distribution sub-menu changes to 

[Cancel Difference], which is used to exit the strain distribution difference state, as shown in Figure 4-6. 

In addition, the [Switch window] function item is added to the [Marker] sub-menu in the strain distribution sub-

menu to switch the marker point between the strain distribution curve and the strain distribution difference curve, 

Figure 4-7 (a) and Figure 4-7 (b) is the result before and after using the [Switch Wilow] function. 

 

Figure 4-7 (a) Marking the strain curve in the difference state of strain distribution 

The marker point information in the test condition area in Figure 4-7 (b) is correspondingly represented as the 

change in strain (or frequency) between the marker points on the difference curve. 

Note! 
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Figure 4-7 (b) Using the menu function [Switch Wilow] to switch the marker points to the position corresponding to the 

difference curve. 

1.3 Spectral width distribution window 

 

Figure 4-8 Display area of "spectral width distribution" state window 

1.3.1 Overview 

Click [Multiwindow] → [Spectral width distribution] to enter the display interface of spectral width distribution. 

The upper right corner of the window display area displays the state as “spectral width distribution”, and the 

function menu area displays the sub-menu of spectral width distribution, and the window display area is as shown 

in Figure 4-8. 

The “spectral width distribution” window displays the spectral width-distance curve, which is used to display the 

Brillouin spectrum distribution of the fiber under test. The size of Brillouin spectrum at different distances of the 

fiber under test can be observed visually by observing this window. 

The vertical line in the window of Figure 4-7 is the cursor, the “0.22530km” below the horizontal axis is the 

distance value of the position where the cursor is located, and “0.063GHz” is the spectral width value of the 

position where the cursor is located 

1.3.2 Description of sub-menu  

The functions of button on sub-menu of spectral width distribution are described as follows: 

[Marker]: The function menu area will display the sub-menu of Marker for setting the marker points in the 

“spectral width distribution” window. 

[Clear]: Clear all the maker points in the “spectral width distribution” window. 

[Global Display]: Restore the zoom state of the spectral width distribution window to the initial state. 

[Exchange Reference]: Exchange the current display curve with the reference curve, switch the current display 

curve to the reference curve, and switch the reference curve to the current display curve. 

[Clear reference]: Clear the reference curve displayed in the software. 
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[Back]: Return to the multiwindow sub-menu, the function menu area will display the multiwindow sub-menu. 

1.3.3 Description of operation  

(1) Cursor movement and coordinate scaling 

① In "spectral width distribution" state, the curve displayed in the window can be zoomed out by clicking the  

 button in the waveform operation area through the left mouse button or the touch screen; the curve 

will shrink along the horizontal direction by pressing the  button, the curve will enlarge along the horizontal 

direction by pressing the  button, the curve will enlarge along the vertical direction by pressing the  button, 

the button curve will shrink along the vertical direction by pressing the  button; the movement of the cursor 

can be moved by clicking the  button,  indicate fast movement, and the  button moves 

the cursor to the left by ten units at a time, the  button moves the cursor to the right by ten units at a time. 

 indicate normal movement, and the  button moves the cursor to the left by one unit at a time, the  

button moves the cursor to the right by one unit at a time. 

② In the "spectral width distribution" state, the arrow direction in the navigation keypad of front panel can be 

used to scale the curve displayed in the window. 

③ The knob buttons on the navigation keypad of front panel can be used to move the cursor in the “spectral width 

distribution” window. Rotate the cursor clockwise to the right and counterclockwise to the left. Click the [Quick] 

button on the front panel, the movement speed of mobile knob will be ten times faster, click the [Quick] button 

again to return to the original speed. 

(2) Operation of maker points of Marker 

① Setting of maker points of Marker 

In the “spectral width distribution" state, the Marker sub-menu can be entered by clicking the [Marker] function 

button under the spectral width distribution sub-menu through the left mouse button, touch screen or menu buttons 

of front panel. At this time, the test condition area displays the Marker information, as shown in Figure 4- 9. 

The order of the four Marker points is Marker1, Marker2, Marker3, and Marker4. 

 

Figure 4-9 Marker interface in the "spectral width distribution" state 

② Description of Marker information 

In the “spectral width distribution” state, the Marker information displayed in the test condition area is shown in 

Figure 4-9, there are two groups of marker information of Marker, namely “Marker1-2” group and “Marker3-4” 

group. 

All information below the "Marker1-2" position belongs to the "Marker1-2" group, and the meaning of the data 

information is as follows. 

Distance: It indicates the difference in distance between marker point 1 and marker point 2, the unit is km, mi. or 

kft. 

Spectral width: It indicates the difference of Brillouin spectral width between marker point 1 and marker point 2, 

Note! 



Chapter IV Description of Window Display 

36 

the unit is GHz. 

Max: It indicates the maximum spectral width of the fiber segment between marker point 1 and marker point 2, 

the unit is GHz. 

Min: It indicates the minimum spectral width of the fiber segment between marker point 1 and marker point 2, the 

unit is GHz. 

Ave: It indicates the average spectral width of the fiber segment between marker point 1 and marker point 2, the 

unit is GHz. 

Std: It indicates the spectral width standard deviation of the fiber segment between marker point 1 and marker 

point 2, the unit is GHz. 

All information below the "Marker3-4" position belongs to the "Marker3-4" group, and its data information 

corresponds to the distance difference, the spectral width difference, the maximum spectral width, the minimum 

spectral width, and the average spectral width, and spectral width standard deviation between marker point 3 and 

marker point 4. 

③ Clearance of Marker points 

In the sub-menu of spectral width distribution, use the mouse, touch screen or menu button of front panel to click 

the[Clear marker]function button under the sub-menu of spectral width distribution to hide all the maker points 

displayed in the [Spectral width distribution] state, as shown in Figure 4-10. 

 

Figure 4-10 Clearing maker points in the "spectral width distribution" state 

The position of set Maker points is temporarily saved in the “spectral width distribution" 

state, but if the user switches from the "spectral width distribution" state to the “strain 

distribution” state, the "loss distribution" state, the "comprehensive loss" state" and the 

“Brillouin spectrum” state, the position of set Maker points that has been temporarily 

saved in the "strain distribution" state will be cleared, so if the maker point is used in the 

next test, please save it in time. 

1.4 Brillouin Spectrum Display dialog box 

 

Note! 
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Figure 4-11 Window display area of “Brillouin spectrum" state 

1.4.1 Overview 

Click [Multiwindow] → [Brillouin spectrum] to enter the display interface of Brillouin spectrum. The upper right 

corner of the window display area displays the state as “Brillouin spectrum”, and the function menu area displays 

the sub-menu of Brillouin spectrum, and the window display area is as shown in Figure 4-11, the sub-menu in 

“Brillouin spectrum” state is displayed as global curve of strain. 

The “Brillouin spectrum” window displays the relative power-sweep frequency curve, which is used to represent 

the Brillouin spectrum curve at the selected distance point of the fiber under test. The relative power value 

corresponding to the sweep frequency at the selected distance point of the fiber under test can be visually 

observed by observing this window. 

The vertical line in the window in Figure 4-11 is the cursor, the “10.53000GHz” below the horizontal axis is the 

sweep frequency value of the selected distance point, “68.549dB” is the relative power value of the position where 

the cursor is located, “0.37423km” is the distance information for the selected distance point at which the 

Brillouin spectrum curve is shown currently. 

1.4.2 Description of sub-menu 

The functions of the sub-menu of Brillouin spectrum are described as follows: 

[Marker]: The function menu area will display the sub-menu of Marker for setting the marker points in the 

“Brillouin spectrum” window. 

[Cursor]: It is used to select distance mode or the frequency mode of cursor movement in the "Brillouin spectrum" 

state. 

[Clear]: Clear all the maker points in the “Brillouin spectrum” window. 

[Global Display]: Restore the zoom state of the Brillouin Spectrum Display dialog box to the initial state. 

[Exchange Reference]: Exchange the current display curve with the reference curve, switch the current display 

curve to the reference curve, and switch the reference curve to the current display curve. 

[Clear reference]: Clear the reference curve displayed in the software. 

[Back]: Return to the multiwindow sub-menu, the function menu area will display the multiwindow sub-menu. 

1.4.3 Description of operation 

(1) After setting the [Cursor] function button in the Brillouin spectrum sub-menu to "distance/frequency", the 

"Brillouin spectrum" window is in the distance mode, and the operation of the selected distance point can be 

performed. 

① In "Brillouin spectroscopy" state, the curve displayed in the window can be zoomed out by clicking the

 button in the waveform operation area through the left mouse button or the touch screen; the curve will 

shrink along the horizontal direction by pressing the  button, the curve will enlarge along the horizontal 

direction by pressing the  button, the curve will enlarge along the vertical direction by pressing the  

button, the curve will shrink along the vertical direction by pressing the  button, the curve will shrink along 

the vertical direction by pressing the  button; the curve of Brillouin spectroscopy in the window 

can change with the change of distance point accordingly by clicking the  button, and the  button moves 

the cursor to the left by ten units at a time, the  button moves the cursor to the right by ten units at a time; the 

 button moves the cursor to the left by one unit at a time; the  button moves the cursor to the right by one 

unit at a time; 

② In "Brillouin spectrum" state, the curve can be enlarged by using the front panel button , or can be 

shrunk by using the front panel button . 

③ Use the knobs on the knob keypad of front panel to control that the Brillouin spectrum curve in the window 

changes with the distance point accordingly. Rotate the cursor clockwise to the right by one unit, and rotate the 

cursor counterclockwise to move the cursor to the left by one unit. Click the [Quick] button on the front panel, the 
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movement speed of mobile knob will be ten times faster, click the [Quick] button again to return to the original 

speed. 

The “Brillouin spectrum” window displays the Brillouin spectrum curve corresponding to 

the selected distance point. Therefore, the selected distance point is changed directly by 

clicking the corresponding position on the global curve of strain with the left mouse button 

or the touch screen in the sub-window. The Brillouin spectrum curve displayed in the 

“Brillouin spectrum” window also changes accordingly. 

(2) After setting the [Cursor] function button to "distance/frequency", the “Brillouin spectrum" window is in the 

frequency mode, and the cursor can be moved and the Brillouin spectrum curve can be scaled. 

① In "Brillouin spectroscopy" state, the curve displayed in the window can be scaled by clicking the 

 button in the waveform operation area through the left mouse button or the touch screen; the curve will shrink 

along the horizontal direction by pressing the  button, the curve will enlarge along the horizontal direction by 

pressing the  button, the curve will enlarge along the vertical direction by pressing the  button, the curve 

will shrink along the vertical direction by pressing the  button, the curve will shrink along the vertical direction 

by pressing the  button; the curve of Brillouin spectroscopy in the window can change with the 

change of distance point accordingly by clicking the  button, and the  button moves the cursor to the left by 

0.05GHz, the button moves the cursor to the right by 0.05GHz; the  button moves the cursor to the left by 

0.005GHz; the  button moves the cursor to the right by 0.005GHz; 

② In "Brillouin spectrum" state, the curve can be enlarged by using the front panel button , or can be 

shrunk by using the front panel button . 

③ The knob buttons on the navigation keypad of front panel can be used to move the cursor in the “Brillouin 

spectrum” window. Rotate the cursor clockwise to the right and counterclockwise to the left by 0.005GHz 

separately. Click the  [Quick] button on the front panel, the movement speed of mobile knob will be ten times 

faster, namely, 0.05GHz by one time; click the  [Quick] button again to return to the original speed. 

(3) Operation of Marker points 

① Setting of maker points of Marker 

In the “Brillouin spectrum" state, the Marker sub-menu can be entered by clicking the [Marker] function button 

under the Brillouin spectrum sub-menu through the left mouse button, touch screen or menu buttons of front panel. 

The test condition area displays the Marker information, as shown in Figure 4-12. 

The order of the four Marker points is Marker1, Marker2, Marker3, and Marker4. 

 

Figure 4-12 Marker interface in the "Brillouin spectrum" state 

② The Marker information of "Brillouin spectrum” is as follows: 

All information below the "Marker1-2" position belongs to the "Marker1-2" group, and the meaning of the data 

information is as follows. 

Note! 

Note! 
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Frequency difference: It indicates the frequency difference between marker point 1 and marker point 2, the unit 

is GHz. 

Loss: It indicates the difference of relative power between marker point 1 and marker point 2, the unit is dB. 

Max: It indicates the maximum relative power between marker point 1 and marker point 2, the unit is dB. 

Min: It indicates the minimum relative power between marker point 1 and marker point 2, the unit is dB. 

Std: It indicates the standard deviation of relative power between marker point 1 and marker point 2, the unit is 

dB. 

All information below the "Marker3-4" position belongs to the "Marker3-4" group, and its data information 

corresponds to the frequency difference (frequency difference) the loss difference (loss), the maximum relative 

power (Max), the minimum relative power (Min), the average relative power (Ave), and relative power standard 

deviation (Std) between marker points 3 and maker point 4. 

③ Clearance of Marker points 

In the “Brillouin spectrum” state, use the mouse, touch screen or menu button of front panel to click the [Clear 

marker] function button under the sub-menu of Brillouin spectrum to hide all the maker points displayed in the 

"Brillouin spectrum" state. 

The position of set Maker points is temporarily saved in the "Brillouin spectrum" state, 

but if the user switches from the "Brillouin spectrum" state to the "strain" state, the "loss 

distribution" state, the "comprehensive loss" state" and the “spectral width” state, the 

position of set Maker points that has been temporarily saved in the "strain distribution" 

state will be cleared. Therefore, if the Brillouin spectrum of the marker point is used in 

subsequent operation tests, it needs to be saved in time. 

1.5 Loss distribution window 

1.5.1 Overview 

Click [Multiwindow] → [Loss Dis.] to enter the interface of loss distribution. The upper right corner of the 

window display area displays the state as “loss distribution”, and the function menu area displays the sub-menu of 

loss distribution, and the window display area is as shown in Figure 4-13. 

 

Figure 4-13 Interface of "loss distribution" state 

The “loss distribution” window is used to display the relative power distribution curve at the selected frequency 

point. If the sub-window is Brillouin spectrum, the selected frequency point is changed in the sub-window, and the 

loss distribution curve displayed in the “loss distribution” window will also have corresponding changes. 

The vertical line in the window of Figure 4-12 is the cursor, the “0.36277km” below the horizontal axis is the 

distance value of the position where the cursor is located, and “84.496dB” is the relative power value of the 

position where the cursor is located 

1.5.2 Description of sub-menu 

Click the [loss Dis.] function button in the multiwindow sub-menu, and the function distribution area will display 

the loss distribution sub-menu. The structure is shown in the function menu area in Figure 4-3. 

Note! 
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[Real-time Test]: Same as the [Real-time Test] function button in the main function menu, the instrument will 

perform real-time loss test on the selected sweep frequency. 

[Marker]: The function menu area will display the sub-menu of Marker for setting the marker points in the “loss 

distribution” window. 

[Cursor]: It is used to select distance mode or the frequency mode of cursor movement in the "loss distribution" 

state. 

[Clear]: Clear all the maker points in the “loss distribution” window. 

[Exchange Reference]: Exchange the current display curve with the reference curve, switch the current display 

curve to the reference curve, and switch the reference curve to the current display curve. 

[Clear reference]: Clear the reference curve displayed in the software. 

[Global Display]: Restore the zoom state of the loss distribution window to the initial state. 

[Back]: Return to the multiwindow sub-menu, the function menu area will display the multiwindow sub-menu. 

1.5.3 Description of operation 

(1) After setting the [Cursor] function button to "distance/frequency", the window is in the distance mode, the 

cursor can be moved or the curve can be scaled. 

① In "loss distribution" state, the curve displayed in the window can be zoomed out by clicking the 

 button in the waveform operation area through the left mouse button or the touch screen; the curve will 

shrink along the horizontal direction by pressing the  button, the curve will enlarge along the horizontal 

direction by pressing the  button, the curve will enlarge along the vertical direction by pressing the  

button, the button curve will shrink along the vertical direction by pressing the  button; the movement of the 

cursor can be moved by clicking the  button,  indicate fast movement, and the  button 

moves the cursor to the left by ten units at a time, the  button moves the cursor to the right by ten units at a 

time.  indicate normal movement, and the  button moves the cursor to the left by one unit at a time, 

the  button moves the cursor to the right by one unit at a time. 

② In the "loss distribution" state, the arrow direction in the navigation keypad of front panel can be used to scale 

the curve displayed in the window. 

③ The knob buttons on the navigation keypad of front panel can be used to move the cursor in the “loss 

distribution” window. 

(2) After setting the [Cursor] function button to “distance/frequency”, the “loss distribution” window is in the 

frequency mode. The button  in the waveform operation area or the knob on the front panel of the 

instrument can be used to change the sweep frequency point. Click the  button to control the 

movement of the frequency point.  indicate fast movement,  moves the cursor to the left by ten 

frequency points at a time,  moves the cursor to the right by ten frequency points at a time  indicate 

normal movement, and the  button moves the cursor to the left by one frequency point at a time, the  

button moves the cursor to the right by one frequency point at a time. 

The  button or the navigation keys on the front panel can be used to scale in horizontal and vertical 

coordinates. The curve will shrink along the horizontal direction by pressing the  button, the curve will enlarge 

along the horizontal direction by pressing the  button; the curve will shrink along the vertical direction by 

pressing the  button, the curve will enlarge along the vertical direction by pressing the  button. 

If the instrument is performing the “real-time test” function at this time, the frequency operation can be performed 

on the “loss distribution” state, the “real-time test” function can be changed to test the sweep frequency point of 

loss distribution curve to make the instrument measure the new loss distribution curve and display it in the loss 

distribution window; if the “real-time test” function is turned off at this time, the frequency operation performed 
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on the “loss distribution” state will have no response. 

(3) Operation of Marker points 

① Setting of maker points of Marker 

In the “loss distribution" state, the Marker sub-menu and Marker information interface can be entered by clicking 

the [Marker] function button under the loss distribution sub-menu through the left mouse button, touch screen or 

menu buttons of front panel, which is shown in Figure 4-14. The function menu [TPA LSA] represents two 

different calculation methods for the loss between points. TPA stands for two-point method and LSA stands for 

least squares method. 

 

Figure 4-14 Marker interface in the "loss distribution" state 

The order of the four Marker points is Marker1, Marker2, Marker3, and Marker4. 

② Information of Marker points 

There are two groups of marker information of Marker, namely “Marker1-2” group and “Marker3-4” group.  

All information below the "Marker1-2" position belongs to the "Marker1-2" group, and the meaning of the data 

information is as follows. 

Distance: It indicates the difference in distance between marker point 1 and marker point 2, the unit is km, mi. or 

kft. 

Loss: It indicates the difference of relative power between marker point 1 and marker point 2, the unit is dB. 

dB/km: It indicates the average loss of the fiber segment between marker point 1 and marker point 2, the unit is 

dB/km. 

All information below the "Marker3-4" position belongs to the "Marker3-4" group, and its data information 

indicates the distance difference (distance) and the difference of relative power (loss) between marker point 3 and 

marker point 4, and average loss (dB/km) of fiber segment between marker points. 

SP: It indicates the splice loss between two segments of fiber, the unit is dB/km. 

If the inter-point loss algorithm in the Marker menu is selected as [TPA LSA], the Marker point information 

becomes the result of the corresponding LSA method. 

③ Clearance of Marker points 

In the “loss distribution” state, use the mouse, touch screen or menu button of front panel to click the[Clear 

marker]function button under the sub-menu of spectral width distribution to hide all the maker points displayed in 

the "loss distribution" state. 

The position of set Maker points is temporarily saved in the "loss distribution" state, but if 

the user switches from the "loss distribution" state to other states, the position of Maker 

points that has been temporarily saved will be cleared. Therefore, if the Brillouin spectrum 

of the marker point is used in subsequent operation tests, it needs to be saved in time. 

1.6 Comprehensive loss window 

1.6.1 Overview 

Note! 

Note! 
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Click [Multiwindow] → [Comprehensive Loss], or click the  (Loss) button on the front panel to enter the 

comprehensive loss interface. The upper right corner of the window display area displays the state as 

“comprehensive loss”, and the window display area is as shown in Figure 4-15. 

 

Figure 4-15 Window display area of “comprehensive loss" state 

The “comprehensive loss” state is used to display the comprehensive loss distribution curve of the fiber under test, 

that is, the distribution curve of the relative power along the distance. The loss distribution of maximum value (ie, 

the center sweep point) and the loss distribution of the mean value of the entire Brillouin scattering spectrum can 

be switched by clicking the [Max Avg] button on the menu. 

The curve in the “comprehensive loss” window is the curve of comprehensive relative power tested by the 

instrument. The vertical line in the window of Figure 4-15 is the cursor. The “0.17922km” below the horizontal 

axis is the distance value of the position where the cursor is located. “93.689dB” is the comprehensive relative 

power value of the position where the cursor is located. 

1.6.2 Description of sub-menu 

Click the [comprehensive loss] function button in the multiwindow sub-menu, and the function menu area will 

display the sub-menu of comprehensive loss. 

[Max Avg]: Used to select the calculation method of comprehensive loss. The button [Max Avg] indicates to 

calculate the comprehensive loss with the maximum loss; the button [Max Avg] indicates to calculate the 

comprehensive loss with the average loss. 

[Marker]: The function menu area will display the sub-menu of Marker for setting the marker points in the “loss 

distribution” window. 

[Clear]: Clear all the maker points in the “comprehensive loss” window. 

[Global Display]: Restore the zoom state of the loss distribution window to the initial state. 

[Exchange Reference]: Exchange the current display curve with the reference curve, switch the current display 

curve to the reference curve, and switch the reference curve to the current display curve. 

[Clear reference]: Clear the reference curve displayed in the software. 

[Back]: Return to the multiwindow sub-menu, the function menu area will display the multiwindow sub-menu. 

1.6.3 Description of operation 

(1) Cursor movement and coordinate scaling 

① The curve displayed in the window can be scaled by clicking the  button in the waveform 

operation area through the left mouse button or the touch screen; the curve will shrink along the horizontal 

direction by pressing the  button, the curve will enlarge along the horizontal direction by pressing the  

button, the curve will enlarge along the vertical direction by pressing the  button, the button curve will shrink 

along the vertical direction by pressing the  button; the movement of the cursor can be moved by clicking the 

 button,  indicate fast movement, and the  button moves the cursor to the left by ten units 
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at a time, the  button moves the cursor to the right by units at a time.  indicate normal movement, and 

the  button moves the cursor to the left by one unit at a time, the  button moves the cursor to the right by 

one unit at a time. 

② The arrow direction in the navigation keypad of front panel can be used to scale the curve displayed in the 

window. 

③ Use the knobs on the knob keypad of front panel to move the cursor in the “comprehensive loss” window: 

Rotate the cursor clockwise to move the cursor to the right, and rotate the cursor counterclockwise to move the 

cursor to the left. Click the [Quick] button on the front panel, the movement speed of mobile knob will be ten 

times faster, click the [Quick] button again to return to the original speed. 

(2) Operation of maker points of Marker 

① Setting of maker points of Marker 

In the “comprehensive loss" state, the Marker sub-menu can be entered by clicking the [Marker] function button 

under the comprehensive loss sub-menu through the left mouse button, touch screen or menu buttons of front 

panel. The test condition area displays the Marker information, as shown in Figure 4-16. 

The function menu displayed in the function menu area is the Marker sub-menu, where the [Max Avg] menu item 

is used to set the calculation of comprehensive loss distribution with the maximum relative power value (Max) or 

the average relative power value (Avg); [TPA LSA] menu item is used to set the calculation of fiber loss between 

points by two point method (TPA) or least squares method (LSA). 

The order of the four Marker points is Marker1, Marker2, Marker3, and Marker4. 

 

Figure 4-16 Marker interface in the "comprehensive loss" state 

② Description of Marker information 

There are two groups of marker information of Marker, namely “Marker1-2” group and “Marker3-4” group. 

All information below the "Marker1-2" position belongs to the "Marker1-2" group, and the meaning of the data 

information is as follows. 

Distance: It indicates the difference in distance between marker point 1 and marker point 2, the unit is km, mi. or 

kft. 

Loss: It indicates the difference of relative power between marker point 1 and marker point 2, the unit is dB. 

dB/km: It indicates the loss per km of the fiber segment between marker point 1 and marker point 2, the unit is 

dB/km. 

All information below the "Marker3-4" position belongs to the "Marker3-4" group, and its data information 

indicates the distance difference (distance) and the difference of relative power (loss) between marker point 3 and 

marker point 4, and loss per km (dB/km) of fiber segment between marker points. 

SP: It indicates the splice loss between two segments of fiber, the unit is dB/km. 

If the inter-point loss algorithm in the Marker menu is selected as [TPA LSA] and [Max Avg], the Marker point 

information changes to the result obtained by the least squares method on the comprehensive relative intensity 

Note! 
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curve calculated by the average loss. The rest can be done in the same manner. 

③ Clearance of Marker points 

In the “comprehensive loss” state, use the left mouse button, touch screen or menu button of front panel to click 

the [Clear marker] function button under the sub-menu of comprehensive loss to hide all the maker points 

displayed in the "comprehensive loss" state. 

The position of set Maker points is temporarily saved in the "comprehensive loss" state, 

but if the user switches from the "comprehensive loss" state to other states, the position of 

Maker points that has been temporarily saved will be cleared. Therefore, if the Brillouin 

spectrum of the marker point is used in subsequent operation tests, it needs to be saved in 

time. 

2 Description of sub-waveform window 

The sub-waveform window is located at the bottom right of the screen, as shown in Figure 4-17. The sub-

waveform window is used to help the user to more conveniently observe the global curve or the Brillouin 

spectrum curve under the "strain distribution" state, "spectral width distribution" state, "loss distribution" state, 

and "comprehensive loss" state; the sub-waveform window under Brillouin spectrum state is displayed as a global 

curve of strain distribution. The type of curve displayed in the sub-waveform window is selected by the 

[Sub.Wave] function button in the main function menu. 

 

Figure 4-17 Sub-waveform window 

(1) [Sub.Wave] The function button is set to [Global Brillouin spectrum]. 

When the window display area is in the "strain distribution" state, the "spectral width distribution" state, the "loss 

distribution" state, and the "comprehensive loss" state, the sub-waveform window will display the global curve of 

Brillouin spectrum of the selected distance point, and its curve is same as the Brillouin spectrum curve displayed 

in the “Brillouin spectrum” window. In the "loss distribution" state, the sweep frequency point can be changed by 

the Brillouin spectrum of the sub-window, and the loss distribution curve in the "loss distribution" window is 

updated with the difference of the sweep points. 

(2) [Sub.Wave] The function button is set to [Global Brillouin spectrum]. 

① If the window display area is in the “strain distribution” state, the sub-waveform window will display the 

global curve of the strain distribution curve. 

② If the window display area is in the “spectral width distribution” state, the sub-waveform window will display 

the global curve of the Brillouin spectrum curve. 

③ If the window display area is in the “loss distribution” state, the sub-waveform window will display the global 

curve of the loss distribution curve. 

④ If the window display area is in the “strain distribution” state, the sub-waveform window will display the 

global curve of the strain distribution curve. 

When the horizontal or vertical coordinate is scaled by the buttons or the navigation keys in the waveform 

operation area, the rectangle marking window on the global curve of the sub-window is used to display the range 

of the distribution curve in the global curve. 

Note! 
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(3) In the “Brillouin spectrum” state, the [Sub.Wave] function button is set to [Global Brillouin spectrum] or 

[Global Brillouin spectrum], and the sub-waveform window displays the global curve of the strain distribution. 

After changing the selected distance point in the sub-window, the Brillouin spectrum curve in the “Brillouin 

spectrum” will change accordingly. 
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Chapter V Description of 3D Display Functions 

1 Overview of state 

Click the [3D display] button in the main function menu to use the 3D display function of the instrument. At this 

time, the window display area displays the “3D” state, and the function menu area displays the 3D display sub-

menu. 

 

Figure 5-1 “3D” state and 3D display sub-menu 

In the "3D" state, the three-dimensional curve of the test data is displayed in the window, wherein the horizontal 

axis is the distance, the vertical axis is the relative intensity, and the oblique axis is the sweep frequency. 

The “3D” state is the most intuitive observation interface. The curve at each sweep frequency point represents the 

loss curve corresponding to the sweep frequency point, and the curve at each distance point represents the 

Brillouin spectrum curve corresponding to the distance point. Therefore, the distribution of the Brillouin spectrum 

on the fiber under test can be visually observed in the "3D" state. 

2 Description of display sub-menu 

The 3D display sub-menu is shown in the function menu in Figure 5-1. The functions of the button are described 

below. 

[3D Loss]: The window display area displays the “loss distribution” state, showing the loss distribution curve at 

the selected frequency point in the “3D” state, and the function menu area displays the loss distribution sub-menu. 

[Cursor]: The cursor mode in the “3D” state can be selected as the distance mode or the frequency mode. After 

selecting the “distance” mode, the distribution of the Brillouin scattering spectrum at different distance points can 

be observed by moving the cursor; after selecting the “frequency” mode, the loss distribution along the fiber 

distance under different sweep points can be observed. 

[Global Display]: Restore the zoom state of the 3D curve to the initial state. 

[Back]: Return to the main function menu, the function menu area will display the main function menu. 

3 Description of display operation 

(1) In the 3D” state, set the [Cursor] function button to “distance/frequency”, the cursor operation mode will be 

in the distance mode, the cursor shape is dark curve as shown in Figure 5-2, and the curve shown by the cursor is 

the Brillouin spectrum curve corresponding to the selected distance point, at this time, the lower right corner of 

the "3D" window displays the distance information of the current cursor. At this time, the cursor movement 

operation or the curve scaling operation can be performed on the horizontal axis. 
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Figure 5-2 “3D” state and 3D display sub-menu 

① The 3D curve displayed in the window can be scaled by clicking the  button in the waveform operation 

area with the left mouse button or the touch screen. The curve will shrink along the horizontal direction by 

pressing the  button, the curve will enlarge along the horizontal direction by pressing the  button. The 

movement of the cursor can be controlled by pressing the  button, the  indicate fast 

movement, and the  button moves the cursor to the left by ten units at a time, the  button moves the cursor 

to the right by ten units at a time.  indicate normal movement, and the  button moves the cursor to the 

left by one unit at a time, the  button moves the cursor to the right by one unit at a time. 

② The buttons  and  on the front panel can be used to scale the horizontal coordinate. 

③ Use the knobs on the knob keypad of front panel to move the cursor in the window: Rotate the cursor 

clockwise to move the cursor to the right, and rotate the cursor counterclockwise to move the cursor to the left. 

Click the [Quick] button on the front panel, the movement speed of mobile knob will be ten times faster, click the 

[Quick] button again to return to the original speed. 

(2) In the 3D” state, set the [Cursor] function button to “distance/frequency”, the cursor operation mode will be in 

the frequency mode, the cursor shape is dark curve as shown in Figure 5-1, and the curve shown by the cursor is 

the loss distribution curve corresponding to the selected distance point and frequency point, the lower right corner 

of the "3D" window displays the frequency information of the current cursor. At this time, the cursor movement 

operation or the curve scaling operation can be performed on the horizontal axis. 

① In the “3D” state, the curve displayed in the window can be operated through clicking the  

buttons in the waveform operation area through the left mouse button or touch screen.  indicate fast 

movement, and the  button moves the cursor to the left by ten units at a time, the  button moves the cursor 

to the right by ten units at a time.  indicate normal movement, and the  button moves the cursor to the 

left by one unit at a time, the  button moves the cursor to the right by one unit at a time. 

② Use the knobs on the knob keypad of front panel to move the cursor in the window: Rotate the cursor 

clockwise to move the cursor to the right, and rotate the cursor counterclockwise to move the cursor to the left. 

Click the [Quick] button on the front panel, the movement speed of mobile knob will be ten times faster, click the 

[Quick] button again to return to the original speed. 
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Chapter VI Description of File Functions 

Click the [File] button in the main function menu to enter the file sub-menu, as shown in the function menu in 

Figure 6-1. The functions of the button are described below. 

[Open]: Enter the file opening interface and read the historical test data of 6419 from the index path to display it 

in the window display area. 

[Save]: Enter the file saving interface and save the data in current window display area to the selected path. 

[Delete]: Enter the file deletion interface to delete the selected files in the path. 

[Transfer]: Enter the file transfer interface and copy the data file selected in the source path to the target path. 

[Open Ref.]: Enter the file opening interface and read the historical test data of 6419 from the index path as 

reference data to display it in the window display area (provided that data already exists in the window display 

area). 

[Back]: Return to the main function menu, the function menu area will display the main function menu. 

 

Figure 6-1 Schematic diagram of file sub-menu 

1 File opening 

Click the [Open] function button in the file sub-menu, and the function menu area displays the sub-menu of file 

opening, including three function buttons of [New Folder], [OK] and [Back]; the state of the upper right corner of 

the window is displayed as "Open File". The file path in the left side of the window is the index bar, including the 

drop-down menu of drive letter selection and the folder (or file) list under the drive letter, showing the remaining 

storage space of the selected drive letter; the right side of the window is the “file path” text box, the file list in the 

index folder, the “file, folder name” text box, and the “file type” drop-down menu from top to bottom, as shown in 

Figure 6-2. 

When opening a file, first select the file type. The "file type" drop-down menu contains two file types: "*.sta" and 

"*.eis". The system defaults to "*.sta"; then select the corresponding file folder in the index path, if the folder 

contains the selected file type, the file list on the right side of the window lists all the files of the type, if not, it is 

empty; finally use the mouse or touch screen to click the required data, click the [OK] function key to open the 

selected file to display it in the window display area. The "*.sta" type file contains all measurement data of 6419, 

including strain, loss, and Brillouin spectrum data; the "*.eis" type file contains only the strain data measured by 

6419. 
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Figure 6-2 File opening interface 

2 File saving 

Click the [Save] function button in the file sub-menu, the function menu area displays the file saving sub-menu, 

including three buttons: [New Folder], [Enter], [Back]; the state of the upper right corner of the window is 

displayed as "save file", the content distribution in the window is same as the file opening window. If only save 

the strain data measured by the instrument, select the “*.eis” type in the file Type drop-down menu, otherwise, 

keep the default “*.sta” file type (since the “*.sta” type file stores more comprehensive information, so opening 

this type of file takes a little longer than compared with opening the "*.eis" type file. Select the target path to be 

stored in the file path index field, then enter the file name in the "file, folder name" text box and click the [OK] 

function key to save the file to the selected path. 

If create a new folder in the file path index bar to store data, enter the folder name in the "file, folder name" text 

box and click the [New Folder] function key, the folder will be newly created in the current file path. Then repeat 

the process of saving the file described in the previous paragraph to save the data file in the newly created folder. 

Soft keyboard input is added to facilitate the input of files or folder names using the mouse or touch screen when 

opening or saving data. When double-click the "file name, folder name" input box with the mouse or touch screen, 

the soft keyboard pops up, as shown in Figure 6-3. 

 

Figure 6-3 File saving interface 

In addition to characters such as numbers in the soft keyboard, "<--", "-->” controls the cursor to move forward or 

backward character by character, and the "Clear" key is used to clear characters from back to front. After inputting, 

use the “OK” button on the soft keyboard to confirm the input file name and exit the soft keyboard, or use the 

“Cancel” button to exit the file name input status. 

3 Open reference 

If the data already exists in the graphics window area, you can open the reference file to compare with it. The 

method for opening the reference file is to use the [Open Ref.] function button in the file sub-menu, and open it 

according to the method described in the second section of this chapter, as shown in Figure 6-4. However, if there 

is no data in the current window display area, the system will pop up a message box to prompt for this operation. 
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Figure 6-4 Interface of opening the reference 

4 Description of file type 

The 6419 distributed optical fiber strain tester saves files in two file types, one in sta format and one in eis format. 

4.1 sta file format 

The sta format is a customized detailed storage format of the 6419 distributed optical fiber strain tester. Under this 

storage format, the 6419 distributed optical fiber strain tester stores all Brillouin gain spectrum data obtained in 

one test for a long time, thus occupying a large capacity. However, the data file stored in this format can further 

analyze the Brillouin spectrum data after reading, including loss distribution, strain distribution, Brillouin 

spectrum center frequency shift distribution, Brillouin spectrum width distribution and other subsequent 

calculations. 

The format can carry out further analysis and data export through the analysis software provided with the 6419 

distributed optical fiber strain tester. The txt format files of loss distribution data, the strain distribution data, the 

Brillouin spectrum center frequency shift distribution data, and the Brillouin spectral width distribution data can 

be exported. 

4.2 eis file format 

The eis format is a customized fast strain data storage format of the 6419 distributed optical fiber strain tester. 

Under this storage format, the 6419 distributed optical fiber strain tester stores the strain distribution data analyzed 

in one test for a short time, thus occupying small capacity, which is more suitable for rapid transmission and 

transfer of a large number of test data. However, the data file stored in this format can only obtain the strain 

distribution data after reading, and the Brillouin spectrum data, the loss distribution data, and the Brillouin 

spectral width distribution data cannot be obtained. 

The data in this format can be exported by the analysis software provided with the 6419 distributed optical fiber 

strain tester, and the txt format file of the strain distribution data can be exported. 

EIS file format: 

＝＝＝＝＝＝＝＝＝＝＝＝＝＝＝＝ File header (accounting for 470 bytes) 

String type: "AV6419” 

String type: "DATD” 

Short type: Number of addition 

Short type: Range, in km. 

int type: Pulse width 

 1 represents 10ns 

 2 represents 20ns 

 3 represents 30ns 

 …… 

 …… 
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 19 represents 190ns 

 20 represents 200ns 

Short type: Sampling resolution 

 0 represents 0.05m 

 1 represents 0.10m 

 2 represents 0.20m 

 3 represents 0.50m 

 4 represents 1.00m 

 5 represents 2.00m 

 6 represents 4.00m 

Double type: Start frequency, in MHz. 

Double type: Ending frequency, in MHz. 

Double type: fB0, in GHz 

Double type: CS, in MHz/με 

Double type: Refractive index 

int type: Frequency interval 

 0 represents 1MHz 

 1 represents 2MHz 

 2 represents 5MHz 

 10 represents 20MHz 

 50 represents 50MHz 

UINT type: Number of data points DATANUM 

int type: Number of frequency points SPECTRUMNUM 

Double type: Starting point of test BEGINDISTANCE 

UINT type: UINT type reserved data 

Double type X33: 33 double type reserved data 

int type X30: 30 int type reserved data 

＝＝＝＝＝＝＝＝＝＝＝＝＝＝＝ Data 

Double type: The stress distribution value of each point in turn, the number of data points is DATANUM, and the 

strain unit is %. 
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Chapter VII Description of System Menu 

1 Description of system sub-menu 

Click the [System] button in the main function menu to enter the system sub-menu. In the system sub-menu, the 

enabling and setting of VFL (visible red light failure system), system settings, system upgrade, and view of system 

information can be performed. 

 

Figure 7 -1 Interface of system sub-menu 

The system sub-menu is shown in the function menu in Figure 7-1, and the functions of buttons are described 

below. 

[VFL]: The VFL control window pops out, the VFL function is turned off and the VFL type is selected. 

[System Self-test]: The system self-check window pops out and the system self-check is performed. 

[System Set]: Enter the sub-menu and setting interface of system settings 

[Touch Cal.]: The touch screen calibration interface pops out to perform touch screen calibration. After calibration, 

it will automatically return to the system interface. 

[Update]: Insert the USB flash drive with the upgrade software into the USB interface of the instrument. Click this 

button to automatically search for the upgrade file in the USB flash drive and perform the system software 

upgrade function. 

[Shut Down]: Execute the instrument shutdown function, pop out inquiry dialog box of confirming the shutdown. 

[Help]: Pop out help sub-menu, the window display area can query the help instructions of the software. 

[Back]: Return to the main function menu, the function menu area will display the main function menu. 

2 Description of VFL functions 

The 6419 has a built-in visible red light fault location (VFL) function that can help determine where the fiber 

breaks and where the light energy leaks. The VFL control window is shown in Figure 7-2. 

 

Figure 7-2 Control window of VFL 
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Select the [VFL] function button in the system sub-menu, and the software will pop out the VFL control window. 

It includes four options: “OFF”, “CW”, “1Hz”, and “2Hz”. The working status of the VFL can be adjusted via the 

navigation key  or  on the front panel. 

(1) Select the "OFF" option, then the VFL function is off; 

(2) Select the “CW” option, the instrument will output continuous visible red light in the VFL optical interface; 

(3) Select the “1Hz” option, the instrument will output visible red light with a frequency of 1Hz in the VFL optical 

interface; 

(4) Select the “2Hz” option and the instrument will output visible red light with a frequency of 2Hz in the VFL 

optical interface. 

3 Description of system self-check functions 

 

Figure 7-3 Interface of system self-check 

In the system sub-menu, select the [System Self-test] function button, the software pops out the system self-check 

interface shown in Figure 7-3, and performs a system self-check on the instrument. If an error is found in the self-

check, a dialog box will pop out. 

4 Description of system settings sub-menu 

 

Figure 7-4 Interface of system settings 

Click the [System Set] button in the system sub-menu to enter the system settings interface, as shown in Figure 7-

4. The system setting interface displays information such as the model number, serial number, software version, 

storage capacity, display parameters, and sampling points. 

[DateTime]: Set the system time or date. Press or click this button, the cursor is positioned in the “hour” setting 

input box in the time format. The buttons in the numeric key area on the front panel of the instrument can be used 

to modify the number in the box, or double-click the input box to input the number in the software disk, and then 

click "OK". 

Click the [Cursor] button in the front panel navigation area to toggle the cursor between "Hour", "Minute" or 
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"Second" in the time format and "Year", "Month" or "Day" in the date format. 

[Language]: Set the software language. Press or click this menu button to expand the language drop-down menu 

in the system setting interface. The front panel navigation keys can be used to select between Chinese and English. 

[Dis.Unit]: Set the distance unit of the instrument system. Press or click this menu button to expand the distance 

unit drop-down menu in the system setting interface. The buttons on the navigation keypad can be used to select 

between km, mi. and kft. (1mi = 1.609344km, 1kft = 0.3048m), press other menu buttons to save the settings. 

[Strain Unit]: Set the display unit of the instrument system strain data to % or με (1με is equivalent to 10^-6, 

which is one millionth). Press or click this menu button to position the cursor in the με radio box. The buttons on 

the front panel navigation keypad can be used to select the unit as % or keep the current unit as με. 

[IP]: Set the network IP address of the instrument. Press or click this menu button to position the cursor in the IP 

address box on the system setting interface and use the number keys on the instrument front panel, or enter the IP 

on the soft keyboard that appears after double-clicking the input box. Then, click OK. 

[Gateway]: Set the instrument network gateway. Press or click this menu button to position the cursor in the 

gateway address box on the system setting interface. The gateway address can be modified by using the keys in 

the numeric area on the instrument front panel. 

[Brighness adjustment]: Set the brightness of the instrument screen. Press or click this menu button to position the 

cursor on the LCD brightness adjustment bar in the system setting interface. Use the front panel navigation keys 

to adjust the brightness. The cursor moves to the left, the screen becomes brighter, and the cursor moves to the 

right, the screen is dimmed. 

In the system settings, the cursor key in the navigation keys can control the cursor to switch in the system setting 

parameter box. The arrow keys can select the previous or next menu option of the currently displayed menu item 

in the drop-down menu options. 

The above menu functions can be realized by touch screen or mouse. Characters should be input in setting the 

time and date, IP, subnet mask and gateway in the interface. Double-click on the mouse or touch screen where you 

need to input, the screen will pop out the numeric keypad, and then click on the keyboard to input. Other settings 

such as the drop-down menu can be realized by clicking directly with the mouse or touch screen. 

The remote connection of the instrument needs to be realized through four network 

parameters: IP address, subnet mask, gateway and network port in the system setting 

interface. Only the instrument network parameters and the remote control host are set in 

the same network segment and share the same network port, so as to achieve remote 

connection. For details, see “Chapter VIII, Section 6 Remote Control”. 

5 Help 

Click the [Help] button in the system sub-menu to pop out the help file as shown in Figure 7-5. The file includes 

three parts: Precautions for using the instrument, maintenance and care of the instrument, and methods of using 

the instrument. 

Precautions for using the instrument: List the basic items to be aware of when using the instrument to avoid 

misuse during operation. Do not look directly at the optical output connector to avoid damage to the body, pay 

attention to port matching, and maintain the purity of the test light, and avoid organic solvents that can damage the 

display. 

Maintenance and care of the instrument: List the temperature and humidity range for the usage and storage of 

instrument, and use regular cleaning tools and proper maintenance methods. 

Methods of using the instrument: Briefly list the basic usage of the instrument to help the user familiar with the 

instrument operation steps and data testing. 

Note! 
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Figure 7-5 Help interface 
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Chapter VIII Application Methods 

1 Basic operation 

1.1 Turn on the instrument 

Step 1: After ensuring that the power supply voltage is 220VAC, use the power cord supplied with the instrument 

to connect to the external AC power supply (as shown in Figure 8-1). 

Step 2: Turn on the power switch on the back panel of the instrument. At this time, the front panel power indicator 

should be orange, indicating that the instrument is in standby mode. 

Power 
switch

Power 
interface

 

Figure 8-1 Slot and switch of back panel power cord 

Step 3: Press the switch on the front panel. At this time, the power indicator changes from orange to green. After 

the instrument starts normally, the initialization test interface is displayed, as shown in Figure 8-2. 

On/Off 

key

 

 

Figure 8-2 On-off key of the front panel 

1.2 Fiber access 

Step 1: Gently unscrew the protective sleeve of the BOTDR interface on the front panel of the 6419 distributed 

optical fiber strain tester. The position of the BOTDR interface is shown in Figure 8-3. 

BOTDR 
Interface  

Figure 8-3 BOTDR interface 

Step 2: Connect the optical connector of the fiber under test to the BOTDR interface. As shown in Figure 8-4, 

there is a groove at the BOTDR optical interface, and a protrusion at the FC/APC fiber connector, align with the 

groove at the BOTDR interface with the protrusion at FC/APC fiber connector. 

Step 3: After aligning the protrusion at the FC/APC fiber connector with the groove at the BOTDR interface, 

slowly push the FC/APC fiber connector into the BOTDR optical interface, and gradually tighten the thread on the 

FC/APC fiber connector. 
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Figure 8-4 Groove of BOTDR interface and protrusion of FC/APC fiber interface 

Note: The BOTDR interface is an FC/APC fiber connector. It does not support access of FC/UPC or other 

types of fiber connectors. If the fiber access connector is not an FC/APC connector, please use the optical 

fiber patch cord (see Appendix D for details). Please check the fiber end face before inserting. If the end 

face is contaminated, it should be cleaned in time (see Appendix F for details). 

1.3 Setting parameters 

Step 1: Click the [Settings] button on the front panel, and the [Settings] key position is as shown in Figure 8-5. 

Enter the test condition interface (you can also enter it by clicking the [Test Condition] button in the main function 

menu), the test condition interface is as shown in Figure 8-6. 

 

Figure 8-5 Setting buttons on the front panel 

 

Figure 8-6 Interface of test condition 

Step 2: Use the touch screen or mouse to set each parameter. The description of each parameter can be seen in 

Chapter II, Section 2. 

Step 3: After the parameters are modified, click [OK], as shown in Figure 8-6, save the test parameters and exit 

the test parameter setting interface. 

1.4 Turn off the instrument 

Step 1: Click the [System] button in the function menu button, as shown in Figure 8-7. 
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Figure 8-7 Position of [System] button 

Step 2: Click the [Shutdown] button in the system sub-menu, as shown in Figure 8-8. 

 

Figure 8-8 Position of [Shutdown] button 

Step 3: After the display is turned off, turn the switch on the back panel of the instrument to the off state, then turn 

off the power and unplug the power cord. If the fiber is no longer used to test, remove the fiber and cover the 

optical connector. 

2 Test operation 

2.1 Strain distribution test of fiber 

Step 1: Connect the fiber under test to the BOTDR optical interface of front panel. For detailed steps, see 

Chapter VIII, Section 1.2. 

Step 2: Set the test parameters according to the parameter values in Table 8-1 below. For detailed steps, see 

Chapter VIII, Section 1.3. 

Table 8-1 Table of initial frequency shift of Brillouin spectrum parameter setting 

Parameter name Parameter value 

Range Set value greater than the fiber length 

Pulse width Set according to requirements of fiber length 

Average times 14 

Resolution 1m/2m/4m 

Refractive index Given by fiber / cable manufacturers 

Starting point 0km 

Continuous test Close 

Output optical power Lower 
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Start frequency For details, see Chapter III, Section 2 

Ending frequency For details, see Chapter III, Section 2 

Frequency interval 5MHz/10MHz 

fB(0) For details, see Chapter III, Section 2 

CS. Given by fiber / cable manufacturers 

Step 3: Click the button [Test] on the front panel or the menu button [Average] to start the strain test. The 

background color of the [Average] button in the main function menu changes to light blue. After the test is 

completed, the [Average] button restores the primary color, the curve of [strain distribution] and [spectral width 

distribution] is displayed in Figure 8-9. 

 

Figure 8-9 [Average] button changes to light blue 

Step 4: Click [Multiwindow] → [Strain Dis.] to enter the strain distribution window as shown in Figure 8-10. The 

specific operation of the strain distribution window is described in Chapter IV, Section 1.2. 

 

Figure 8-10 Interface of optical fiber strain distribution curve 

The vertical line in the window of Figure 8-10 is the cursor, the “7.94286km” below the 

horizontal axis is the distance value of the position where the cursor is located, and “4781.5µε” 
is the spectral width value of the position where the cursor is located. 

2.2 Loss distribution test of fiber 

Step 1: Follow steps 1-3 in Section 2.1 of this chapter; 

Step 2: Click [Multiwindow] → [Comprehensive Loss] on the main interface to enter the comprehensive loss 

window as shown in Figure 8-11. For detailed operation of the comprehensive loss window, see Chapter IV, 

Section 1.6. 

Note! 
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Figure 8-11 Comprehensive loss curve of fiber 

The curve in the “comprehensive loss” window is the curve of comprehensive relative power 

tested by the instrument. The vertical line in the window of Figure 8-11 is the cursor. The 

“7.94286km” below the horizontal axis is the distance value of the position where the cursor is 

located. “86.870dB” is the comprehensive relative power value of the position where the cursor 

is located. 

2.3 Brillouin spectrum test of fiber 

Step 1: Follow steps 1-3 in Section 2.1 of this chapter; 

Step 2: Click [Multiwindow] → [Brillouin spectrum] on the main interface to enter the Brillouin Spectrum 

Display dialog box as shown in Figure 8-12, change the selected distance point, and observe the measured 

Brillouin spectrum curve of fiber under test corresponding to each distance point. For detailed operation of the 

Brillouin Spectrum Display dialog box, see Chapter IV, Section 1.4. 

 

Figure 8 -12 Brillouin Spectrum Display dialog box 

The vertical line in the window in Figure 8-12 is the cursor, and the “7.94286km” below the 

horizontal axis is the distance information of the selected distance point where the current 

Brillouin spectrum curve is located. “10.87000GHz” is the sweep frequency value 

corresponding to the cursor, and "86.767dB" is the relative power value of the position where 

the cursor is located. 

2.4 Brillouin spectral width test 

Step 1: Follow steps 1-3 in Section 2.1 of this chapter; 

Step 4: Click [Multiwindow] → [Spectral width distribution] to enter the spectral width distribution window as 

shown in Figure 8-13. The specific operation of the spectral width distribution window is described in Chapter IV, 

Section 1.3. 

Note! 

Note! 
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Figure 8-13 Spectral width distribution curve 

The curve in the “spectral width distribution” window is the distribution curve of Brillouin 

spectral width along the fiber tested by the instrument. The vertical line in the window of Figure 

8-13 is the cursor. The “7.94286km” below the horizontal axis is the distance value of the 

position where the cursor is located. “0.042GHz” is the spectral width value of the position 

where the cursor is located. 

2.5 Fiber length test 

Method 1: Connect the fiber to the fiber interface, and measure the comprehensive loss curve of the fiber 

according to the range, pulse, resolution, and refractive index set in Section 2.3. It can be seen from the figure that 

the loss curve has fallen in a certain area. Position the cursor in this area as shown in Figure 8-14. Click  on 

the front panel to enlarge the area, then slowly rotate the front panel knob clockwise. It is seen that the Brillouin 

spectrum of the sub-window gradually becomes clear. After crossing a certain point, the Brillouin spectrum 

suddenly disappears, as shown in Figure 8-15, the point can be considered as the end of the fiber, and the position 

is 24.63712km. 

6  

Figure 8-14 Comprehensive loss curve of the fiber under test 

Note! 
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Figure 8-15 Brillouin spectrum disappears after crossing a certain point 

Method 2: Connect the fiber to the fiber interface, and measure the spectral width distribution curve of the fiber 

as shown in Figure 8-16 according to the range, pulse, resolution, and refractive index set in Section 2.5. 

6  

Figure 8-16 Spectral width distribution curve of fiber under test 

It is seen that the spectral width value falls at a certain point, the point can be considered as the end of the fiber, 

and the length of the fiber can be obtained from the reading on the lower left corner is 24.63915km. 

2.6 Continuous test of fiber strain 

Step 1: Click the [Settings] button on the front panel or the [Test Condition] on the main interface menu to enter 

the test condition interface; 

Step 2: Select “ON” through the continuous test drop-down menu to start the continuous test. At the same time, 

the continuous test option will appear on the test condition setting interface: Time, Autosave options, if select 

autosave, File No., File type, and SavePath can be set, as shown in Figure 8-17. After setting the parameters, 

click OK and click the [Test] button on the front panel to start the test. 

 



Chapter VIII Application Methods 

63 

Figure 8-17 Continuous test parameter setting 

After the continuous test option is turned on, the user starts the average processing test and enters the continuous 

test state. The instrument will time and measure according to the time interval setting value until the user stops the 

average processing test. 

3 Visible red light fault location (VFL) function 

The 6419 has a built-in visible red light fault location (VFL) function that can help determine where the fiber 

breaks and where the light energy leaks. 

Step 1: Connect the fiber under test to the VFL optical interface of front panel. VFL optical interface is shown in 

Figure 8-18, for detailed steps, see Chapter VIII, Section 1.2. 

VFL 
Interface  

Figure 8-18 VFL interface with protective cover 

Step 2: Select the [VFL] function button in the system sub-menu (or click the VFL
VFL

) button on the front panel) 

and the software will pop out the VFL control window. As shown in Figure 8-19, there are four options: [OFF], 

[CW], [1Hz], and [2Hz]. The mouse or touch screen adjusts the working state of the VFL. 

 

Figure 8-19 Control window of VFL 

Step 3: Set the VFL function in the VFL window according to the needs. Select the [CW] option, the instrument 

will output continuous visible red light in the VFL optical interface; select [1Hz] option, the instrument will output 

the visible red light with a frequency of 1Hz in the VFL optical interface; select [2Hz] option, the instrument will 

output the visible red light with a frequency of 2Hz in the VFL optical interface. 

Step 4: Check the fiber line and the end of the fiber. If there is no red light at the end of the fiber and a large 

amount of red light is emitted at a certain position in the fiber line, check whether the fiber at the red light 

emission position is broken or a small radius bend occurs. 

Step 5: After the VFL function is used, set the VFL option to [OFF] in the VFL window to disable the VFL 

function. 

Step 6: Remove the fiber under test from the VFL optical interface and cover the VFL optical interface protection 

cover. 
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4 File management 

6419 BOTDR internally contains a file management system, which can quickly and accurately process test data, 

including operations such as opening, saving, deleting, transferring, and opening reference files. Press the [File] 

key on the front panel or the [File] button on the main interface menu to enter the file management interface, the 

details are as below. 

4.1 Open the data file 

Step 1: Click [File] → [Open] on the main interface to enter the interface as shown in Figure 8-20. 

 

Figure 8-20 File opening interface 

Step 2: Select the index disk in the file opening interface of Figure 8-20, list the information tree under the index 

disk, select the file folder and file type, all the files in the folder will be listed, select the files to be opened from 

the list, and click [OK] to open the file. 

4.2 Save the data files 

Step 1: Choose File > Save on the main interface, and the interface displayed in Figure 8-21 will be displayed. 

 

Figure 8-21 File saving interface 

Step 2: Select the index disk in the file save interface as shown in Figure 8-21 to list the information tree under 

the index disk, select the target folder and file type (if necessary, click [New Folder] to create a new target path 

folder), double-click the file name input box to pop out the numeric keys on the soft keyboard or front panel to 

enter the saved target file name, and click [OK] to save the file. 

6419 BOTDR save files in two types, one is .sta format, which will store all the Brillouin 

spectrum distribution data obtained by the test. The storage time is long and the occupying 

capacity is large, but the Brillouin spectrum data can be read after further analysis; the other 

is .eis format, which only saves the strain distribution data. The storage time is short and the 

occupying capacity is small, which is more suitable for data transmission and transfer. A 

detailed description of the file type can be found in Chapter VI, Section 4. 

4.3 Delete the data files 

Note! 
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Step 1: Click [File] → [Delete] on the main interface to enter the interface as shown in Figure 8-22. 

 

Figure 8-22 File deleting interface 

Step 2: Select the index disk in the file deleting interface of Figure 8-22, list the information tree under the index 

disk, select the file folder and file type, all the files in the folder will be listed, select the files to be deleted from 

the list, and click [OK] to delete the file. 

4.4 Open the reference files 

Step 1: Click [File] → [Open Ref.] on the main interface to enter the interface as shown in Figure 8-23. 

 

Figure 8-23 Interface of opening the reference 

Step 2: Select the index disk in opening the reference interface of Figure 8-23, list the information tree under the 

index disk, select the file folder and file type, all the files in the folder will be listed, select the reference files to be 

opened from the list, and click [OK] to open the reference file. 

Step 3: As shown in Figure 8-24, the reference curve interface is displayed. The test data and the reference data 

are drawn in different colors. The blue curve is the test data, and the red curve is the reference file data. 

 

Figure 8-24 Image of reference files 
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Note: The range of the reference file data should be consistent with the range of the original file data, 

otherwise, it will not be used as a reference! 

4.5 Transfer the data files 

Step 1: Click [File] → [Transfer] on the main interface to enter the interface as shown in Figure 8-25. 

 

Figure 8-25 File transfer interface 

Step 2: In the file transfer interface of Figure 8-25, select the source index disk, select the folder and file type, and 

select the file to be transferred. 

Step 3: Select the target drive letter, select the target folder, and press the [Copy] or [Copy All] button to transfer 

the data file in the source folder to the target location. 

5 Waveform comparison function 

Step 1: Open the reference file through the method in Section 4.3 of this chapter and enter the multiwindow 

reference file interface, as shown in Figure 8-26. 

 

Figure 8-26 Main interface of multiwindow file reference 

Step 2: Click [Multiwindow] → [Strain Dis.] in the main interface to enter the strain distribution reference 

interface, and perform the curve operation by zooming in and out on the interface and moving the buttons left and 

right, as shown in Figure 8-27. 
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Figure 8-27 Reference interface of strain distribution 

Step 3: Same as step 2, click [Multiwindow] → [Spectral Width Distribution], [Brillouin spectrum], [Loss 

Distribution] and [Comprehensive Loss] in the main interface respectively to enter the corresponding curve 

interface. 

Note: The reference file will not open when the range of the current data does not match the range of 

opening the reference file. 

6 Remote control function 

Step 1: Connect the network cable (crossover type) to the Ethernet interface of the tester and computer 

respectively; 

Step 2: Configure the IP address of the instrument. On the main interface, click [System] → [System Set] to enter 

the system configuration interface. Enter the IP address and gateway through the soft keyboard or the numeric 

keys on the front panel to ensure that the instrument and the computer are in the same network segment. Click the 

[OK] button to save the IP address, as shown in Figure 8-28. 

 

Figure 8-28 Interface of system settings 

Step 3: After setting the IP address as shown in 8-28, the instrument will save the current address. The instrument 

control port number is 8080, which cannot be modified. After the setting is completed, the instrument will be 

restarted, and the remote control of the instrument can be performed through the client. 

Step 4: Use the host computer in the same IP segment to control the instrument test according to the list of related 

remote control commands in Appendix B through the network. For details, see Section 7 in Appendix A.
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Chapter IX General Faults and Processing Methods 

1 Quick check of general fault 

Table 9-1 shows the possible faults and solutions for the instrument: 

Table 9-1 Faults and solutions 

Fault Possible reasons Solutions 

The instrument 

can’t be started. 

The switch of back panel is in the 

“OFF” position. 
Turn the switch on the back panel to the “ON” position. 

The AC power cord is not plugged in. Insert the AC power cord correctly. 

The button does not 

respond. 

Check whether there’s a button is 

pressed down all the time 
Make sure that no button is pressed down. 

The soft keyboard is in the pop-out 

state. 
Close the soft keyboard. 

The measured fiber 

length is inaccurate. 

The fiber refractive index setting is 

inaccurate. 

Set the fiber refractive index to the refractive index 

calibrated by the fiber manufacturer. 

For details, see Chapter II, Section 2. 

The calibration data of length is lost Contact the manufacturer 

The loss distribution 

curve can’t be seen 

When the frequency setting range 

deviates from the initial frequency 

shift to a large extent, the image is 

shown in Figure 9-2 in Section 2 of 

this chapter. 

Set correct range of scanning frequency 

Poor connection of fiber connector 

(1) Please check whether the fiber connector is 

contaminated, if necessary, check it with fiber end face 

microscope and make it clean; 

(2) Check whether the fiber connector is not properly 

inserted and tightened (see Chapter VIII, Section 1 for 

details). 

The flange ceramic core of BOTDR 

interface is contaminated or worn. 
Please return to factory for repair. 

The type of fiber port is not matched 
Please check whether the fiber connector is FC/APC type 

(see Appendix D for details) 

There is a large loss point at the near 

end of the fiber. 

Connect the fiber to the VFL test end and start the VFL 

function check (see Chapter VIII, Section 6 for details). 

The test starting point is set 

incorrectly and exceeds the length of 

the fiber under test. (See Chapter IX, 

Section 3 for details.) 

Re-adjust the position of test starting point. 

The loss distribution 

curve is abnormal, 

and the attenuation 

is large at a long 

distance. 

The test range is smaller than the fiber 

length. 

Reset the appropriate test range and the test range is 

required to be longer than the length of the fiber under test 

(see Chapter VIII, Section 1 for details). 

The power of the probe light is too 

large. 

Adjust the output optical power in the “test condition” (see 

Chapter XI, Section 4 for details). 

The Brillouin 

scattering spectrum 

is not visible. 

The frequency setting range deviates 

from the initial frequency shift to a 

large extent. 

Set correct range of scanning frequency(see Chapter VIII, 

Section 1 for details). 

The frequency setting range is too 

small. 

Set correct range of scanning frequency(see Chapter VIII, 

Section 1 for details). 

The interval of frequency scanning is 

too large 

Appropriately reduce the frequency scanning interval (see 

Chapter VIII, Section 6 for details). 

The display 

brightness of LCD is 

The LCD brightness setting is 

incorrect. 
Click [System] → [System Set.] → [Brighness adjustment] 

to adjust the LCD display brightness appropriately (see 
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too dark. Chapter VI, Section 6 for details). 

The touch screen 

cannot be clicked to 

the correct position. 

The touch screen is not calibrated. 
Click [System] → [Touch Screen Calibration] to calibrate 

the touch screen. For details, see Chapter XI, Section 7. 

2 Setting of refractive index 

 

Figure 9-1 Setting interface of refractive index 

Click the [Settings] button on the front panel to enter the test condition interface shown in Figure 9-1.Enter the 

refractive index in the refractive index input box or double-click the input box to input with the soft keyboard. 

The refractive index is given by the fiber/cable manufacturer (refer to Chapter III, Section 2.5) and the 

starting point is set to zero. 

3 Solutions when the frequency setting range deviates from the initial frequency shift to a large extent 

Figure 9-2 shows the image when the frequency setting range deviates from the initial frequency shift to a large 

extent. There are several reasons for this situation, which will be analyzed one by one as follows. 

 

Figure 9-2 Image when the frequency setting range deviates from the initial frequency shift to a large extent 

1. The starting and ending frequencies are too deviated and too narrow to include the initial frequency shift of 

Brillouin spectrum. 

Solution: Set the Start frequency to 9.9GHz and the ending frequency to 12GHz. The frequency interval is set to 

20MHz. The Brillouin spectrum can be swept out, as shown in Figure 9-3. From this, the initial frequency shift of 

Brillouin spectrum can be roughly determined. In this figure, the initial frequency shift of Brillouin spectrum is 

10.85000GHz, and the subsequent operation method is as described in Chapter VIII, Section 2. 
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Figure 9-3 Brillouin spectrum 

2. When the initial and ending frequencies are deviated to the left, the Brillouin spectrum shown in Figure 9-4 will 

appear. 

 

Figure 9-4 Starting and ending frequency deviated to the left 

Solution: Move the starting and ending frequencies to the right, or use the current ending frequency as the 

approximate value of the initial frequency shift of Brillouin spectrum, and set the starting and ending frequencies 

to fB (0)-fy, fB (0)+fy. Table 9-2 shows the correspondence relation between common pulse width and spectral 

width. If the ending frequency is appropriately increased when measuring the tensile deformation, the ending 

frequency should be appropriately reduced when measuring the compression deformation. 

Table 9-2 Correspondence relation between common pulse width and spectral width 

Pulse width (ns) Fy (GHz) 

10 0.2 

20 0.1 

50 0.05 

100 0.05 

200 0.05 

3. When the starting and ending frequencies are deviated to the right, the Brillouin spectrum shown in Figure 9-5 

will appear. 
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Figure 9-5 Frequency spectrum of starting and ending frequency deviated to the right 

Solution: Move the starting and ending frequencies to the left, or use the current Start frequency as the 

approximate value of the initial frequency shift of Brillouin spectrum, and set the starting and ending frequencies 

to fB (0)-fy, fB (0)+fy. Table 9-3 shows the correspondence relation between common pulse width and spectral 

width. If the Start frequency is appropriately increased when measuring the tensile deformation, the ending 

frequency should be appropriately reduced when measuring the compression deformation. 

Table 9-3 Correspondence relation between common pulse width and spectral width 

Pulse width (ns) Fy (GHz) 

10 0.2 

20 0.1 

50 0.05 

100 0.05 

200 0.05 

4. The starting point of test is set incorrectly and exceeds the length of the fiber under test, the loss distribution 

curve shown in Figure 9-6 will appear (in this figure, the measurement starting point is 1.02109km, and the actual 

length of the fiber is 1km). 

 

Figure 9-6 Loss distribution curve when the starting point is set incorrectly 
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Figure 9-7 Setting interface of starting point 

Solutions: As shown in Figure 9-7, the starting point distance should be re-adjusted (since the 6419 can collect the 

data of up to 80,000 distance points. When the sampling point is less than 80,000, the starting point setting is 

invalid, when the distance sampling point is greater than 80000, the starting point setting value will take effect, 

and the starting distance of the test data of 6419 will be the setting value of starting point). Table 9-4 is a table of 

the relationship between resolution and range when the starting point takes effect. 

Table 9-4 Relationship between resolution and range when the starting point takes effect. 

Resolution (m) Range (km) 

0.05 ≥4 

0.1 ≥8 

0.2 ≥16 

0.5 ≥40 

1 ≥80 

2 ≥128 

4 Adjustment of optical power 

As shown in Figure 9-8, after clicking the drop-down menu of output optical power, users can choose from four 

options: Relatively low, low, medium and high, providing optical power of different intensities. 

 

Figure 9-8 Adjustment interface of optical power 

5 Relationship among common pulse width, resolution and length measurement 

Table 9-5 shows the relationship among common pulse width, resolution and length measurement for users' 

reference. 
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Table 9-5 Relationship among common pulse width, resolution and length measurement 

Pulse width (ns) Spatial resolution (m) Length measurement (km) 

10 1 10 

20 2 15 

50 5 30 

100 10 40 

200 20 80 

6 Brightness adjustment 

Click [System] → [System Set] to enter the system setting interface shown in Figure 9-9, click the LCD brightness 

through the touch screen, move the screen to the left to make it darken, and move the screen to the right to make it 

brighten, or the brightness can be controlled by the arrow direction on the front panel, move the left or upper 

arrow to make the screen darken, and move the right or lower arrow to make the screen brighten. 

 

Figure 9-9 Interface of system settings 

7 Calibration of touch screen 

Click [System] → [Touch Cal.] to enter the interface as shown in Figure 9-10. 

 

Figure 9-10 Calibration interface of touch screen 

Then calibrate the touch screen by clicking on the red circle in the figure. 
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Chapter X Working Principles 

1 Fiber optic sensing technology 

Compared with traditional sensing technology, optical fiber sensing technology has shown great advantages. 

Compared with traditional electrical and mechanical sensor technologies, optical fiber sensing technology has 

unparalleled advantages in many applications due to its own characteristics. It’s featured by resistance to 

electromagnetic interference, corrosion resistance, small size, variable shape, high sensitivity and many sensing 

objects. It provides a very effective means for measuring in certain special industrial environments (such as 

flammable, explosive, high voltage, high current, high current field interference, etc.). 

2 Distributed optical fiber sensing technology 

The distributed optical fiber sensor not only has the advantages of general fiber-optic sensors, but also realizes 

continuous real-time monitoring of large-scale information fields through optical fibers, such as tens to hundreds 

of kilometers of measurement range, which makes the acquisition cost of unit information greatly reduced, greatly 

improving the cost performance. The distributed fiber optic sensing is used in a wide range of applications to 

monitor physical changes in buildings, dams, bridges, tunnels and oil pipelines, and submarine cables. 

3 Spontaneous Brillouin scattering 

Under normal temperature conditions, atoms, molecules or ions in the fiber undergo continuous elastic mechanical 

vibration due to self-heating motion, forming a spontaneous acoustic wave field in the light. Acoustic vibrations 

along the direction of the fiber cause the density of the fiber to periodically change with time and space such that 

the index of refraction index on the fiber is periodically modulated. This spontaneous acoustic wave can be 

thought of as a density grating moving along the fiber at a certain speed (and with a certain frequency). Therefore, 

Brillouin can be seen as the scattering of incident light on a moving grating. The Doppler effect causes a 

frequency shift of the scattered light relative to the incident light, called the frequency shift of Brillouin spectrum. 

The spontaneous Brillouin scattering can occur in the forward and backward directions. The frequency shift of 

Brillouin spectrum Bv
in the fiber can be expressed as: 
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                                                                            (10.1)  

Where, av
 is the speed of sound, n is the refractive index of the fiber material, and λp is the wavelength of the 

incident light in free space. For a typical quartz fiber, n = 1.45, av
 = 5.96km/s, and the incident light wavelength 

is 1,550nm, the frequency shift of Brillouin spectrum is about 11.2GHz. 

If the acoustic wave in the fiber is assumed to be exponentially attenuated, the Brillouin scattering spectrum is a 

Lorentz curve shape with the following formula: 
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Where, ΔvB is the full width at half maximum (FWHM) of the Brillouin gain spectrum, and its relationship with 

Γb is ΔvB = Γb/2π, and the phonon lifetime Γb = Tb-1, usually less than 10ns. For a common fiber with ΔvB as 

dozens of MHz, gP is the value of the Brillouin gain spectrum at the frequency shift of Brillouin spectrum, i.e.: 
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Where, p12 is the longitudinal elastic coefficient and ρ0 is the density of the medium. For the incident light of 

1.55um wavelength, the Brillouin gain coefficient gp is approximately equal to 5*10
-11

m/W by taking the typical 

parameter value of the quartz fiber into the above equation. 
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Figure 10-1 Brillouin scattering gain spectrum 

4 BOTDR technology 

BOTDR is a distributed optical fiber sensing technology that uses spontaneous Brillouin scattering, its basic 

principle is to sensor the temperature/strain using the spontaneous backward Brillouin scattering effect of the fiber, 

and combines OTDR technology to achieve the positioning of the sensing parameters. BOTDR is a single-ended 

measurement method, which is more convenient to use in practical engineering applications. BOTDR technology 

uses optical pulses to locate the sensing parameters. In addition to the limitation of the spatial resolution of the 

system to the pulse width, since Brillouin scattering is the collision of photons and phonons, if the pulse width is 

smaller than the phonon lifetime, it will lead to the sharp decrease of the measurement accuracy of the sensing 

parameter, and the lifetime of the phonon is about 10 ns, so the spatial resolution achievable by the BOTDR 

technique is on the order of m (meter). 

Its basic structure is shown in Figure 10-4. The optical pulse is injected into one end of the sensing fiber, and the 

spontaneous Brillouin scattering in the backward scattered light replaces Rayleigh scattering as a function of time, 

with temperature and stress distribution information along the fiber, and the temperature and strain distribution in 

the fiber can be obtained after measuring the frequency shift of Brillouin scattering. 
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Figure 10-2 Schematic diagram of the basic structure of the spontaneous Brillouin scattering 

Due to the interaction between the pump light injected into the fiber and the dielectric crystal structure in the fiber, 

the incident pump light is scattered, resulting in a Stokes frequency shift, in addition to generating the Rayleigh 

scattered light and the Fresnel reflected light of the same frequency as the pumping light in the opposite direction 

to the incident light, there is another kind of scattered light with Stokes frequency shift, that is, Brillouin scattering 

light, which is called frequency shift of Brillouin spectrum relative to the Stoke frequency shift of pump light 

frequency. As shown in Figure 10-3, the frequency shift of Brillouin spectrum is related to the material of the fiber 

and the wavelength of the pump light injected into the fiber. For the quartz fiber, when the wavelength of the 

pump light is 1550nm, the frequency shift is around 11GHz. 

The theory shows that the frequency shift of Brillouin spectrum fB (0) of the fiber has linear relationship with 

strain and is expressed as follows: 

)1)(0()( BB   SCff ＝
                                                                      (10.4) 

Where, ε is the strain of the fiber, fB (0) is the frequency shift of Brillouin spectrum of the fiber without strain, i.e. 
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the initial frequency shift of Brillouin spectrum, Cs is the strain coefficient of the fiber frequency shift of Brillouin 

spectrum, and is a constant related to the fiber material and the wavelength of the probe light. For a conventional 

G.652 single mode fiber, the strain coefficient Cs is typically approximate to 493MHz/%, or 0.0493MHz/με at a 

1,550 nm detection wavelength. The formula is expressed as follows: 
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                                                              (10.5) 

 

Figure 10-3 Schematic diagram of Brillouin scattering light spectrum 

The meaning of 1% strain: If the 1m fiber changes to 1.01m, the strain of the fiber is 1%, 100με corresponds to 

0.01%, and 1με corresponds to 0.0001%, and the strain is a relative change amount of zero dimension. 

The calculation formula of the fiber length can be obtained according to the following formula: 

n
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                                                                            (10.6) 

Where, c is the velocity of light in vacuum; t is the time interval between the initial transmitted pulse and the 

returned optical signal; n is the refractive index of the fiber under test. Since light travels back and forth twice in 

the fiber, the fiber length should be multiplied by a factor of 1/2. 
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Chapter XI Technical Parameters 

1 General characteristics 

The general characteristics of the 6419 distributed optical fiber strain tester are shown in Table 11-1. 

Table 11-1 General characteristics of 6419 distributed optical fiber strain tester 

NAME CONTENT 

DISPLAY 10.4" color LCD 

OPTICAL OUTPUT CONNECTOR FC/APC TYPE (STANDARD TYPE) 

EXTERNAL INTERFACE LAN PORT, RS232 PORT, VGA, USB PORT, HEADPHONE JACK 

POWER SUPPLY 220VAC ± 10％, 50HZ ± 5％ 

ENVIRONMENTAL REQUIREMENTS 

OPERATING TEMPERATURE: 0°C ~ 40°C 

STORAGE TEMPERATURE: 0°C ~ 50°C 

RELATIVE HUMIDITY: ≤ 85%, NO CONDENSATION 

DIMENSIONS Width × Height × Depth: 435 × 230 × 495 (mm) 

WEIGHT About 19kg 

POWER SUPPLY 100 ～ 240VAC (1.5A), frequency allowable range: 50/60Hz 

MAXIMUM POWER CONSUMPTION  ≤ 100W 

VFL 650nm ± 30nm, 2mW (typical); working status: CW, 1HZ, 2Hz 

2 Main functions 

1. System power-on self-test function; 

2. Chinese interface and Chinese menu display functions; 

3. Strain distribution test function; 

4. Brillouin scattering spectrum test function; 

5. Fiber distance test function; 

6. Fiber loss distribution test function; 

7. VFL (visible red light fault location) function; 

8. Multiwindow display function; 

9. Real-time date and time display function; 

10. File management function； 

11. Color LCD display and brightness adjustable functions; 

12. Touch screen operation function; 

13. Remote control function; 

14. Timing test and data storage functions; 

15. Function of online upgrade of system software. 

3 Main technical indicators 

1. Operating wavelength: 1,550nm ± 5nm 

2. Distance-measuring error: ± (0.2 + 2 × 10
-5

 × distance + 2 × sampling interval) (m) 

3. Maximum spatial resolution: 1m 

4. Maximum dynamic range: 15dB 

5. Strain test accuracy: ≤ ± 50με (10 ~ 20ns pulse width) 

≤ ± 10με (50~200ns pulse width) 
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6. Repeatability of strain test: better than ± 100με 

7. Strain test range: -15,000 ~ +15,000 (με) 

8. Setting range of refractive index: 1.00000~1.99999, minimum step size: 0.00001 

9. Distance-measuring range: 0.5, 1, 2, ..., 128km optional, 1km step 

10. Test pulse width: 10, 20, 30, ..., 200ns optional, 10ns step 

11. Maximum sampling points: 80,000 

12. Setting range of average times: 2
10

~2
24

 

13. Scale type of strain display: %, με 

14. Scale type of distance display: km, mi., kft. 

15. Horizontal distance readout resolution: 0.05m 

16. Vertical strain readout resolution: 1με 

17. Scale range of vertical strain display: 10～+20,000 (με) 

18. Vertical strain display range: -80,000～+80,000 (με) 

19. Scale range of vertical Brillouin spectrum display: 1.0dB~10.0dB 

20. Frequency scanning range: 9.9GHz to 12GHz 

21. Frequency scanning interval: 1, 2, 5, 10, 20 and 50MHz are optional 

22. In-machine storage capacity: ≥ 25GB 

23. LCD display: 10.4 inches, display resolution is 1024 × 768 

24. External electrical interface: VGA, RS232C, USB, Ethernet, support keyboard and mouse 

25. External optical interface: FC/APC 
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Appendix A Instruction for Use of the Analysis Software 

The 6419 analysis software is used to read data files tested and saved by the 6419 optical fiber strain analyzer on 

the PC, and perform the remote control function. It has a standard version of 6419 Analyser Standard and 

professional version of 6419 Analyser Professional. The standard version is attached with the purchased analyzer 

while the professional version is charged extra and needs a specific annotation in an order. 

1 Software Installation 

1.1Runtime Environment 

Table A-1 Recommended 6419 runtime environment 

Operating system Windows XP and later versions of Windows operating system 

Memory More than 2G 

Hard disk More than 60G 

CPU Higher than 3.0GHz 

Screen resolution 1,920 x 1,080 pixels 

1.2 Installation Procedures 

Taking the standard version as an example, perform the following steps to install the software: 

Step 1 Run setup.exe in the installation package of the standard analysis software. The Select Installation 

Language dialog box is displayed, as shown in Figure A-1. Select the required language and click Next. 

 

Figure A-1 Select Installation Language dialog box 

Step 2 The installation software displays a dialog box indicating the installation preparation progress. After the 

preparation is complete, the Welcome dialog box is displayed. Click Next. The License Agreement dialog box is 

displayed, as shown in Figure A-2. Click I accept the terms in the license agreement (A) and Next. 

 

Figure A-2 License Agreement dialog box 

Step 3 In the displayed User Information dialog box, specify the user name and company name, as shown in 

Figure A-3. Then, click Next. 
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Figure A-3 User Information dialog box 

Step 4 The Select Installation Type dialog box is displayed, as shown in Figure A-4. If you click Full Installation 

and Next, the software installs all application functions in the default system path. If you click Custom Installation, 

you need to specify the software installation path and functions. Click Next. The Select Installation Path dialog 

box is displayed. Click Change to specify a new path for saving the software installation files. Then, click Next. 

The Select Software Function dialog box is displayed. Select the function to be installed and click Next. 

 

Figure A-4 Select Installation Type dialog box 

Step 5 In the Conform Installation dialog box, click Next to enter the Installation Progress dialog box. After the 

installation is complete, a dialog box will be automatically displayed, indicating successful installation. Click 

Finish to finish installing the software. 

1.3 Software Running 

After the 6419 analysis software is installed, taking the standard version for example, you can choose Start > 

Programs > CETC > 6419 Analyzer Standard > 6419 Analyzer Standard to run the analysis software. Alternatively, 

you can search the software installation path for the 6419 Analyzer Standard application to run it, as shown in 

Figure A-5. 

1.4 Software Uninstallation 

After the 6419 analysis software is installed, taking the standard version for example, you can choose Start > 

Programs > CETC > 6419 Analyzer Standard > Uninstall Application to uninstall the analysis software. 

Alternatively, you can uninstall it by using Add/Remove Programs in the Control Panel or the professional 

uninstallation software.
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2 Software Interface 

 

Figure A-5 Software interface 

As shown in Figure A-5, the software interface consists of the following: 

① File command button: Reads, exports, and prints data files. 

② Function area: Includes functions such as data file display and analysis, settings, and remote control. 

③ Curve list: Lists curves of files read. 

④ Marker information bar: Displays marker information. 

⑤ Status bar: Displays parameters is like the data measurement range and sampling resolution, and the coordinate 

value corresponding to the cursor location. 

⑥ Image display area: Displays the curve of data read in the specified display mode. 

⑦ Quick launch toolbar: Sets the tools frequently used, which is on the top of the interface by default. 

3 Data Reading 

Click the file operation button. A drop-down list is displayed, as shown in Figure A-6. 

 

Figure A-6 File operation button menu 

Choose Read File from the drop-down list. A dialog box is displayed, as shown in Figure A-7. The dialog box is 

divided into three areas from left to right: The left area displays a navigation tree to find a specified file; the 

middle area contains the file list and the Read Mode drop-down list; the right area lists files read. 

 

Figure A-7 Read File dialog box 
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Perform the following steps to read a file: 

(1) Select the format of a file to be read from the left navigation tree. Two file formats are required: *.sta and *.eis. 

An .sta file contains data information including the strain distribution, maximum loss, and Brillouin spectrum; 

while an .eis file contains only strain information. 

(2) Select a folder from the left navigation tree. The files in a specified format will be displayed in the middle area. 

(3) Click Add All or Add to add files from the left area to the middle area (considering the limit to the largest 

number of files to be read). Up and Down are used to adjust the file sequence on the read list; Remove or Remove 

All are used to delete files from the read list. 

(4) Select a Read Mode from the middle Read Mode drop-down list. 

(5) Click Conform to load files on the read list. 

The Read Mode drop-down list consists of Brief Reading and Detailed Reading. The 

Brillouin spectrum can be displayed only when you select Detailed Reading. 

In the standard analysis software (6419 Analyser Standard), two files can be read by using 

Brief Reading and Detailed Reading every time respectively. In the professional analysis 

software (6419 Analyser Professional), a maximum of 100 files can be read by using Brief 

Reading and a maximum of 20 files can be read by using Detailed Reading every time. 

4 Data Display 

4.1 Display Mode 

As shown in Figure A-8, the Display Mode functional group framed in red includes Display Strain, Center 

Frequency, and Maximum Loss. 

 

Figure A-8 Display Mode functional group on the Start tab 

Display Strain is highlighted by default after a file is read. Therefore, the file read is displayed as a strain curve in 

the graphic display area. If you need to view data about the center frequency and maximum loss in the file, click 

Center Frequency and Maximum Loss. The corresponding curves will be displayed in the graphic display area. 

4.2 Marker Placement 

The marker placement tool is in the Marker Placement functional group on the Start tab, as shown in Figure A-9, 

which includes M1 (Marker 1), M2 (Marker 2), M3 (Marker 3), and M4 (Marker 4) four marker placement tools 

and a marker deletion tool. The four markers must be placed in sequence from M1 to M4. 

Alternatively, you can right-click on the graphic display area and obtain the preceding functions in the displayed 

shortcut menu. 

 

Figure A-9 Marker Placement functional group on the Start tab 

You can use the marker placement tool as follows: Select a file to be marked with a marker from the curve list, 

click and locate the cursor (blue vertical line in the graphic display area) on the curve to the marker location, and 

click a marker placement tool. The blue cursor line will turn red; the sequence number of the marker will be 

displayed on the upper right of the blue cursor line; the marker information will be displayed in the marker 

information bar. Display Strain is used as an example. After a marker is placed, the graphic display area is 

displayed, as shown in Figure A-10. 

Note! 

Note! 
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Figure A-10 Results of marker placement in Display Strain mode 

The marker point information bar of Marker consists of two columns: Marker1-2 group and Marker3-4 group. In 

particular, Marker1-2 group displays the coordinate information including the maximum vertical coordinate value 

(Max), minimum vertical coordinate value (Min), average vertical coordinate value (Avg), standard deviation of 

the vertical coordinate (Std) of Marker1 and Marker2, and the coordinate difference between Marker1 and 

Marker2 (Diff), while Marker3-4 group displays the coordinate information including the maximum vertical 

coordinate value (Max), minimum vertical coordinate value (Min), average vertical coordinate value (Avg), 

standard deviation of the vertical coordinate (Std) of Marker31 and Marker4, and the coordinate difference 

between Marker3 and Marker4 (Diff) 

4.3 Curve Information 

The Curve Information functional group framed in red on the Start tab consists of Detailed Information and 

Brillouin Spectrum, as shown in Figure A-11. 

 

Figure A-11 Curve Information functional group on the Start tab 

4.3.1 Detailed Information 

Click Detailed Information. The Detailed Information dialog box is displayed, as shown in Figure A-12. 

 

Figure A-12 Detailed Information dialog box 

The Detailed Information dialog box displays data information in the reading sequence, including measurement 

parameters such as File Name, Curve Color, Display, Cursor, and Pulse Width, as well as the marker information. 

In particular, Curve Color and Display can be configured. 

Display: Controls whether the curve is displayed in the graphic display area.  

Curve Color: Sets the curve color of a corresponding file. You can click on the curve to enter the Color Settings 

dialog box. 

Display All and Hide All in the lower right corner of the dialog box control whether to display or hide all files on 

the read list. 

The modified settings of Curve Color and Display take effect after you click Conform in the lower right corner. 

4.3.2 Brillouin spectrum 

This function takes effect when you choose the detailed Read Mode. Click Brillouin Spectrum. The Brillouin 

Spectrum Display dialog box is displayed, as shown in Figure A-13. It shows the Brillouin spectrum of a data file 

selected from the curve list at the location of the cursor. Re-click Brillouin Spectrum. The Brillouin Spectrum 
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Display dialog box is closed. 

 

Figure A-13 Brillouin Spectrum Display dialog box 

In the Brillouin Spectrum Display dialog box, you can right-click and choose Copy Image from the displayed 

shortcut menu to copy the displayed Brillouin spectrum to the clipboard as required. 

4.4 Curve Zooming 

To view the detailed information of a part of the curve, zoom in the part. To be specific, click on the graphic 

display area and hold the cursor to the lower right. After the cursor is released, the selected area is zoomed in. 

After the curve is zoomed in, click on the curve and hold the cursor to the upper left. Then, the curve is zoomed 

out after you release the cursor. 

4.5 Cursor Operation 

In the graphic display area such as the Brillouin Spectrum Display dialog box, click to locate the cursor. The 

located cursor is displayed as a blue vertical line. Alternatively, you can move the cursor by using the Cursor 

Operation functional group framed in red on the Start tab, as shown in A-14. 

 

Figure A-14 Cursor Operation functional group 

: Moves the cursor left one data point horizontally. 

 (First from left): Moves the cursor right one data point horizontally. 

: Moves the cursor left 10 data points horizontally. 

: Moves the cursor right 10 data points horizontally. 

 (Second from left): Displays the Go To dialog box after being clicked, as shown in Figure A-15. Enter the 

location the cursor goes to and click OK. The cursor goes to the specified location. 

 

Figure A-15 Go To dialog box 

The Cursor Operation button is of great help for precise movement, making up for the shortcoming of the cursor 

that is difficult to locate the movement precisely. 

4.6 Settings 
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The Settings tab consists of four functional groups: Parameter, Unit, Display, and Language. It is used to set the 

color, unit, parameters, and display language for the data curves displayed. The following details the settings of 

the parameters and strain unit. 

Parameter: Is used to modify data parameters. The data curve will be refreshed based on new parameters. Figure 

A-16 shows the Parameter functional group. 

 

Figure A-16 Parameter functional group on the Settings tab 

The Parameter functional group consists of three buttons: CS (coefficient of strain), fB0, and Refractive Index. 

Click a button to enter the related setting dialog box, as shown in Figures A-17(a) to (c). Enter related parameters 

in the input box and click Confirm to confirm settings. After the preceding three parameters are modified, the 

curve in the graphic display area will be refreshed based on new parameters. 

 

Figure A-17 (a) CS Settings dialog box 

 

Figure A-17 (b) fB0 Settings dialog box 

 

Figure A-17 (c) Refractive Index Settings dialog box 

Strain Unit: Is used to set the strain unit, highlighted as shown in Figure A-18. Click Strain Unit. In the displayed 

shortcut menu, με and % are available. Once a unit is chosen, the shortcut menu is hidden. If the strain curve is 

displayed in the graphic display area, the unit of the longitudinal axis will change accordingly. In addition, all 

other information related to the strain unit will change accordingly. 

 

Figure A-18 Strain Unit functional group on the Settings tab 

5 Data Analysis 

The Analysis tab is configured with functions including Splicing, Difference, and Multi-peak, among which 

Splicing and Multi-peak are unavailable temporarily. 

As shown in Figure A-19, when the cursor hovers on Difference, this button is highlighted. Click Difference. A 

shortcut menu containing Single-curve Difference and Multi-curve Difference is displayed. Choose an option to 

enter the related dialog box. 

 

Figure A-19 Difference function 

The multi-curve difference function is available only in the professional software (6419 Note! 
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Analyser Professional). 

As shown in Figure A-20, the left part of the Single-curve Difference dialog box lists files. The upper part lists the 

principal strain files while the lower part lists the reference strain files. The right part of the dialog box consists of 

three graphic display boxes. The upper one displays the principal strain curve; the middle one displays the 

reference strain curve; the lower one displays the difference strain curve. 

 

Figure A-20 Single-curve Difference dialog box 

All files read are listed on the two read lists. Click files of a reference strain curve and principal strain curve in the 

left pane. The corresponding reference strain curve, principal strain curve, and difference curve between the two 

are displayed in the graphic display area in the right pane. The strain difference curve has the same color as the 

principal strain curve. Click a color box in the Select Principal Strain Curve area. The Color Settings dialog box is 

displayed, used to set the display color for the related curve. The function of curve zooming in section 4.4 “Curve 

Zooming” also works here. 

Right-click on any graphic display box. A shortcut menu including functions such as marker placement and data 

export is displayed, as shown in Figure A-21. 

 

Figure A-21 Data analysis shortcut menu 

Based on the marker placement methods provided in section 4.2 “Marker Placement”, place markers in the current 

graphic display box by using the marker placement tool on the shortcut menu. The difference strain curve is 

displayed as shown in Figure A-22. The lower left corner of the box displays the corresponding distance and strain 

value of each marker, and the maximum value (Max), minimum value (Min), average value (Avg), and standard 

deviation (Std) of each pair of markers. If you set markers on a curve in a graphic display box in the Difference 

Analysis dialog box, the curves in the other two graphic display boxes will be set synchronously. 

 

Figure A-22 Marker placement and information 

Data Export is used to export the curve data in the current three graphic display boxes to the folder specified by 

the user in .txt format. The file includes the test parameters of the principal and reference strain curves, as well as 

raw data and strain difference data of the two, as shown in Figure A-23. 
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Figure A-23 Data exported from single-curve difference analysis 

(1) If you right-click a selected reference strain curve on the read list and choose Data 

Export from the displayed shortcut menu, all files in the principal strain curve list, and the 

strain information and difference strain information of the selected reference strain file 

are exported. 

(2) If you right-click on the reference strain curve list and choose Data Export from the 

displayed shortcut menu, all files in the principal strain curve list, and the strain 

information and difference strain information of the first reference strain file are exported. 

6 Data Export and Print 

6.1 Data Export 

The function allows exporting information in .sta files read, including the strain, center frequency, and maximum 

loss to .txt files respectively. For details about the operation, see section 5.1. 

Only strain information can be exported from .eis files. 

6.1.1 Using the Export Tab 

As shown in Figure A-24, the Export tab framed in red consists of Strain, Center Frequency, Maximum Loss, and 

All Types. The former three are used to export the related data information in the file read to a specified directory 

in .txt format with the original file name. Clicking All Types means to export the three types of data 

simultaneously. 

 

Figure A-24 Data Export functional group on the Export tab 

6.1.2 Using the File Operation Button 

As shown in Figure A-25, in the menu bar, you can export data by choosing the file operation button > Export 

Data > Export to TXT File/Export Strain/Export Center Frequency/Export Maximum Loss. The four items on the 

Export Data submenu have the same functions of the four on the Export tab. In particular, Export to TXT File 

equals to All Types. 

Note! 

Note! 
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Figure A-25 File operation button menu and Export Data submenu 

A case study of exporting strain data shows that the exported .txt file contains test parameters and the strain value 

at the corresponding location, as shown in Figure A-26. 

 

Figure A-26 Data in the exported strain file 

6.1.3 Shortcut Menu 

In the graphic display area, right-click on the curve. A shortcut menu is displayed, as shown in Figure A-27. The 

menu contains five marker placement tools, as described in section 3.2 “Marker Placement.” 

Copy Image is used to copy the image in the current graphic display area to the clipboard. 

Copy Spectrum Data is used to copy the Brillouin spectrum data of a selected file at the location of the cursor in 

the graphic display area to the clipboard. 

 

Figure A-27 Shortcut menu in the graphic display area 

Copy Spectrum Data is available only in the professional software (6419 Analyser 

Professional). 

6.2 Print 

The file print function is available by choosing the file operation button > Print. Alternatively, you can add Print to 

the quick access toolbar via Custom Settings on the quick access toolbar. As shown in Figure A-28, you can 

perform the quick print function by choosing the file operation button > Print > Quick Print. 

Note! 
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Figure A-28 Print submenu 

The Print submenu consists of Print Preview, Print Settings, and Quick Print. You are recommended to configure 

print settings first and preview the print by choosing Print Preview before printing. 

6.2.1 Print Settings 

Choose Print > Print Settings. The Print Settings dialog box is displayed, as shown in Figure A-29. The dialog box 

consists of five areas: Print Curve, Printer, Print Content, Print Parameters, and Print Style. 

 

Figure A-29 Print Settings dialog box 

The Print Curve area lists data files currently read. Select a file to be printed by selecting the check box in front of 

the file name. 

The Printer area allows selecting a printer to print files and setting the printer properties. 

The Print Content area consists of File Information and Test Conditions. The file information includes the file 

name and test time, and the test conditions mean the file test conditions. After an option is selected, the printed file 

contains the corresponding content. 

The Print Style area is used to set the print style for files in the Print Curve list. You can specify Print Style and 

Paper Orientation. The Print Style drop-down list contains Single-copy Print, Dual-copy Print, and Quad-copy 

Print. If Quad-copy Print is chosen and the paper orientation is longitudinal, you can preview print in the lower 

right corner, as shown in Figure A-29. 

6.2.2 Print Preview 

Choose Print > Print Preview to enter the Print Preview dialog box. The Print Preview functional group consists of 

Print, Zoom, and Preview, as shown in Figure A-30. You can preview the print via the Zoom and Preview 

functions. If the print is unsatisfactory, you need to click Close on the Print Preview tab to reconfigure print 

settings; otherwise, click Print on the left. 

 

Figure A-30 Print Preview 

6.2.3 Quick Print 
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It allows printing data files in the curve list based on the current default print settings. 

7 Remote Control 

The analysis software allows you to remotely control the instrument by choosing Remote Control > Connection 

Parameters/Remote Control/Disconnect, as shown in Figure A-31. 

 

Figure A-31 Remote Control tab 

7.1 Connection Parameters 

Choose Remote Control to enter the Remote Control dialog box, as shown in Figure A-32. 

 

Figure A-32 Remote Control dialog box 

In the Remote Control dialog box, enter the IP address of the target instrument to be remotely controlled in the 

Target IP Address box and 8080 in the Telecommunication Port Number box that is the same as the 

telecommunication port number of the target instrument. As described in section 8.6 “Remote Control,” keep the 

IP address, subnet mask, and gateway of the host installed with the analysis software and the target instrument in 

the same network segment. Then, click Connect to perform the remote control on the instrument. If the connection 

is successful, this dialog box is automatically closed; otherwise, a connection failure message box is displayed. 

7.2 Remote Control 

After remote connection is successful, choose Remote Control to enter the Remote Control dialog box, as shown 

in Figure A-33. It is divided into the test condition operation area and graphic display area. The test condition 

operation area consists of Run Parameters and Command Action. The Run Parameters group box allows 

specifying test conditions. The right pane shows the strain curve tested by the instrument. The lower section 

displays Start Test, Stop Test, and Save File. 

 

Figure A-33 Remote Control dialog box 

The Run Parameters area has the same contents as the test condition operation area. However, it is divided into 

three areas based on parameter properties: Optical Sampling Parameters, Frequency Scanning Parameters, and 

Start Continuous Test. You can specify parameters like Range, Pulse Width, Average Times, Sampling Resolution, 

and Frequency Interval by double-clicking a parameter value, clicking  on the right of the parameter value input 

box, and selecting a value from the displayed drop-down list. You can specify parameters like Refractive Index, 

Test Start Point, Start Frequency, Stop Frequency, fB (0), and CS by double-clicking a parameter value and 
entering a value where the cursor appears. You can synchronize the preceding parameter settings to the test 

conditions of the instrument by clicking Set Parameters in the lower part of Run Parameters. The Refresh List 

button allows reading the current test conditions of the instrument into the Run Parameters area. 
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The Command Action area provides functions like parameter query, parameter setting, and sending remote control 

command, as shown in Figure A-34. 

 

Figure A-34 Command Action in the Remote Control dialog box 

The Query drop-down list contains all items of the optical sampling and frequency scanning parameters. Select an 

item and click Query. The parameter value of this item will be displayed in the lower Query Results text box. 

The Setting drop-down list similarly contains all items of the optical sampling and frequency scanning parameters. 

Select an item, and the input box on the right displays a drop-down list or number input box. 

The Send Command drop-down list lists commands in Appendix B “Remote Control Command Set.” Select a 

command and click Send Command to send the command to the target instrument. If a query command is selected, 

the results returned will be displayed in the Query Results text box. 

Clear List is used to clear contents of the Query Results text box. 

Start Test and Stop Test enable the instrument to start or stop a test. When the instrument is running a test, the 

progress bar is displayed in the graphic display area. If the test is complete, the strain curve tested by the 

instrument is displayed in the graphic display area. 

The lower part of the graphic display area shows data results and contains three lines. Line 1 shows the distance 

and strain value at the cursor location; line 2 shows the location and strain value of each marker; line 3 shows the 

maximum value (Max), minimum value (Min), average value (Avg), and standard deviation (Std) of markers 1 

and 2 and markers 3 and 4. 

7.3 Disconnect 

After exiting from the Remote Control dialog box, click Disconnect to disconnect the remote connection. 

8 Status Bar and Quick Access Toolbar 

8.1 Status Bar 

In the lower left of the software window, the status bar shows in sequence the range and sampling resolution of 

data currently read when being tested by default. X and Y values are the coordinate values on the corresponding 

curve of the current cursor. 

Right-click on the status bar. The Status Bar Configuration dialog box is displayed. You can set the contents 

displayed in the status bar, as framed in red in Figure A-35. 

 

Figure A-35 Status Bar Configuration dialog box 

8.2 Quick Access Toolbar 

The quick access toolbar is used to set the tools frequently used, which is on the top of the interface by default. 

Click  on the right of the toolbar. A drop-down list is displayed for customizing the quick access toolbar. In 

particular, you can set the quick access command, change the toolbar display position, and minimize the 

functional area, as shown in Figure A-36. 
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Figure A-36 Quick access toolbar 

In the drop-down list as shown in Figure A-36, choose More Commands. A dialog box for customizing the quick 

access toolbar is displayed, as shown in Figure A-37. In this dialog box, you can add the selected quick access 

tools to the quick access toolbar and set the display position of the quick access toolbar and corresponding 

shortcut keys. 

 

Figure A-37 Quick access toolbar 
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Appendix B 6419 Remote Control Command Set 

Table B-1 6419 remote control command set 

Remote Control Command Description Value (String) 

:SENSe:CONDition:Model? 
Queries the equipment 

model. 
Equipment model returned, such as AV6419. 

:SENSe:CONDition:ID? 
Queries the serial 

number. 
Serial number returned, such as 201706001. 

:SENSe:CONDition:Version? 
Queries the software 

version. 
Software version returned, such as Ver 2.001. 

:SENSe:CONDition:RANGe? Queries the range. Current range returned, such as 0.5km. 

:SENSe:CONDition:RANGe<value> Sets the range. 

0 or an integer from 1 to 127, separated from the 

preceding SCPI command with a space. The 

values are corresponding to 0.5km, 1km to 

127km. 

:SENSe:CONDition:PULSewidth? Queries the pulse width. Current pulse width returned, such as 10ns. 

:SENSe:CONDition:PULSewidth<value> Sets the pulse width. 

An integer from 1 to 20, separated from the 

preceding SCPI command with a space. The 

values are corresponding to 10～200ns. 

:SENSe:CONDition:AVERage? 
Queries the average 

times. 

Current average times returned, such as 10, 

indicating that the average times is 2
10

. 

:SENSe:CONDition:AVERage<value> Sets the average times. 

An integer from 10 to 24, separated from the 

preceding SCPI command with a space. The 

value is the index of 2. 

:SENSe:CONDition:RESolution? 
Queries the sampling 

resolution. 

Current sampling resolution returned, such as 

0.05m. 

:SENSe:CONDition:RESolution<value> 
Sets the sampling 

resolution. 

An integer from 0 to 6, separated from the 

preceding SCPI command with a space. The 

values are corresponding to 0.05m, 0.10m, 

0.20m, 0.50m, 1.00m, 2.00m and 4.00m. 

:SENSe:CONDition:IOR? 
Queries the refractive 

index. 
Current refractive index returned, such as 1.472. 

:SENSe:CONDition:IOR<value> Sets the refractive index. 

A number greater than 1 and less than 2, such as 

1.47200 or 1.46800, separated from the 

preceding SCPI command with a space. 

:SENSe:CONDition:STARtsamplept? Queries the start point. Current test start point returned, such as 0.39996. 

:SENSe:CONDition:STARtsamplept<value

> 
Sets the start point. 

Configured based on the current range and 

sampling resolution and separated from the 

preceding SCPI command with a space. 

:SENSe:CONDition:INTErvalfreq? 
Queries the frequency 

interval. 

Current frequency interval returned, such as 

1MHz. 

:SENSe:CONDition:INTErvalfreq<value> 
Sets the frequency 

interval. 

An integer from 0 to 7, separated from the 

preceding SCPI command with a space. The 

values are corresponding to 1MHz, 2MHz, 

5MHz, 10MHz, 20MHz and 50MHz. 

:SENSe:CONDition:fB? Queries fB (0). Current fB (0) returned, such as 10.60000. 

:SENSe:CONDition:fB<value> Sets fB (0). 

A number greater than 9.9 and less than 12.0, 

such as 10.7 or 10.75, separated from the 

preceding SCPI command with a space. The unit 

is GHz. 

:SENSe:CONDition:CS? Queries the coefficient of Current coefficient of strain returned, with a unit 
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strain. of MHz/με, such as 0.05000. 

:SENSe:CONDition:CS<value> 
Sets the coefficient of 

strain. 

A number greater than 0 and smaller than 1, such 

as 0.5 or 0.66, separated from the preceding 

SCPI command with a space. The unit is 

MHz/με. 

:SENSe:FREQuency:STARt? 
Queries the start 

frequency. 

Current start frequency returned, such as 

10.70000. 

:SENSe:FREQuency:STARt<value> Sets the start frequency. 

A number greater than 9.9 and smaller than 12, 

such as 10.700 or 10.751, separated from the 

preceding SCPI command with a space. The unit 

is GHz. The value is correct to three decimal 

places and the start frequency must be less than 

the cut-off frequency. 

:SENSe:FREQuency:STOP? 
Queries the stop 

frequency. 

Current cut-off frequency returned, such as 

10.90000. 

:SENSe:FREQuency:STOP<value> Sets the stop frequency. 

A number greater than 9.9 and smaller than 12, 

such as 10.700 or 10.751, separated from the 

preceding SCPI command with a space. The unit 

is GHz. The value is correct to three decimal 

places and the start frequency must be less than 

the cut-off frequency. 

:SENSe:CONDition:LIGHtpower? 
Queries the output 

optical power. 

Current output optical power returned, such as 

Lower. 

:SENSe:CONDition:LIGHtpower<value> 
Sets the output optical 

power. 

An integer from 0 to 3, separated from the 

preceding SCPI command with a space. 

In particular, 0 corresponds to Lower; 1 

corresponds to Low; 2 corresponds to Middle, 

and 3 corresponds to High. 

:SENSe:CONDition:ReadAllPara 
Reads the parameter 

structure. 

Parameter structure received after the command 

is issued. It contains information about test 

parameters of the current equipment. For details 

about struct Send, see the next table. 

:SENSe:CONDition:WriteAllPara 
Sets the parameter 

structure. 

Parameter structure containing parameter 

information configured by users sent after the 

command is issued. For details about struct Send, 

see the next table. 

:IMMediate:AVERage:STARt Starts a test. Starting average processing. 

:IMMediate:AVERage:STOPt Stops a test. Stopping average processing. 

:SENSe:CONDition:Teststate? Queries the test status. 

Test status returned after a query: 

-1 indicates test error; 0 indicates test complete; 

A number greater than 0 indicates the current 

number of test points. 

:SENSe:CONDition:SendTstData Reads an .eis test file. 

Test results returned: 

0 indicates no valid data currently. 

A file size indicates that testing is complete and 

the file is ready to be returned. Then, the server 

enters the wait state and the user can send the 

required package number to request the server 

for the required folder. The packet number can be 

calculated based on the file size and 2044, 

greater than or equal to 0. If a number less than 0 

is sent, file transfer is ended. The file read via 

remote control is in .eis format. For details about 

the .eis format, see section 6.4.2 “EIS File 
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Format.” 

Structure description: 

struct Send 

{ 

int   D_Range; 

int   D_PulseWidth; 

int   D_AVERage; 

int   D_RESolution; 

double  D_IOR; 

double  D_STARtsamplept; 

int   D_INTErvalfreq; 

double  D_fB; 

double  D_CS; 

double  D_STARfreq; 

double  D_ENDfreq; 

int   D_LIGHtpower; 

}; 

Table B-2 Data name description 

Data Type Data Name Description 

int D_Range 
Selects the range. Optional. It is an integer ranging from 0 to 127, corresponding 

to 0.5km, 1km to 127km. 

int D_PulseWidth 
Sets the pulse width. Optional. It is an integer ranging from 1 to 20, 

corresponding to 10～200ns. 

int D_AVERage 
Selects the average times. It is an integer ranging from 0 to 23, corresponding to 

the index of 2. 

int D_RESolution 
Selects the sampling resolution. Optional. It is an integer ranging from 0 to 6, 

corresponding to 0.05m, 0.1m, 0.2m, 0.5m, 1.00m, 2.00m, and 4.00m. 

double D_IOR Sets the refractive index, such as 1.472. 

double D_STARtsamplept Sets the start point of sampling. The value is a number such as 0. 

int D_INTErvalfreq 
Selects the frequency interval. Optional. It is an integer ranging from 0 to 5, 

corresponding to 1MHz, 2MHz, 5MHz, 10MHz, 20MHz and 50MHz. 

double D_fB Sets fB (0), such as 10.6. 

double D_CS Sets the coefficient of strain, such as 0.5. 

double D_STARfreq Sets the start frequency, such as 10.3. 

double D_ENDfreq Sets the stop frequency, such as 10.7. 

int D_LIGHtpower 
Selects the output optical power. Optional. It is an integer ranging from 0 to 3, 

corresponding to Lower, Low, Middle, and High. 

Sample code of remote control: 

//Read test file: 

void FileRead() 

{ 

  char OrderBuf[50]; 
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  char RecvData[2048]; 

  int RecvLength; 

  strcpy(OrderBuf,":SENSe:CONDition:SendTst"); 

  send(Socket,OrderBuf,strlen(OrderBuf),0);//Send the file read command 

  RecvLength=recv(Socket,RecvData,2048,0);//Receive file size 

  DWORD FileSize; 

  int num,rem; 

  FileSize=atoi(RecvData); 

  num=FileSize/2044;//Calculate the total number of packets to be transferred 

  rem=FileSize%2044; 

  if(rem!=0) 

    num++; 

  CFile File; 

  File.Open("6419.eis", CFile::modeCreate|CFile::modeWrite|CFile::modeRead); 

  char NumberBuf[10]; 

  for(int i=0;i<num;i++)//Request packets from the instrument in sequence from the beginning 

  { 

    itoa(i,NumberBuf,10); 

    send(Socket,NumberBuf,strlen(NumberBuf),0); 

    RecvLength=recv(Socket,RecvData,2048,0); 

    File.Write(RecvData+4,RecvLength-4);//Write the last 2044 bytes in the received packets 

  } 

  strcpy(NumberBuf,"-1"); 

  send(Socket,NumberBuf,strlen(NumberBuf),0);//Send -1 to notify the instrument that file transfer is complete 

  File.Close(); 

} 

//Process of a test: 

void main() 

{ 

  char OrderBuf[50]; 

  char TestState[50]; 

  strcpy(OrderBuf,":IMMediate:AVERage:STARt"); 

  send(Socket,OrderBuf,strlen(OrderBuf),0);//Send the test start command 

  strcpy(OrderBuf,":SENSe:CONDition:Teststate?"); 

  send(Socket,OrderBuf,strlen(OrderBuf),0);//Query the test status 

  recv(Socket,TestState,strlen(TestState),0); 

  int State; 

  State=atoi(TestState); 

  while(State!=0)//Query the test status recursively 
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  { 

    send(Socket,OrderBuf,strlen(OrderBuf),0); 

    recv(Socket,TestState,strlen(TestState),0); 

    State=atoi(TestState); 

    if(State==-1) 

    { 

      MessageBox("Test error!") ; 

      return; 

    } 

    MessageBox("No. State point tested currently!") ; 

  } 

  MessageBox("Test complete!") ; 

  FileRead();//Read test file 

} 

Appendix C 6419 Ordering Information 

6419-XX-X-XXX

CN：Simplified Chinese

EN：English

S：Standard analysis software

P：Professional analysis software

Host

Option No.

 

Remarks:For details about the option No., see section section 1.2.2 “Option.” 
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Appendix D Identification of FC/APC from FC/UPC and Patch Cord Connection 

1 FC/APC and FC/UPC Optical Fiber Connector 

Usually called bevel connection, the FC/APC connector has an 8-degree oblique angle at the end, as shown in 

Figure D-1. 

 

Figure D-1 FC/APC 

 

Figure D-2 FC/UPC 

The FC/UPC connector is flat without any oblique angle, as shown in Figure D-2. Usually, there is another way to 

differentiate between the two connectors. 

 

Figure D-3 FC/APC green label 

Usually, the protector under the FC/APC connector is green, as shown in Figure D-3. 

 

Figure D-4 FC/UPC black label 

The protector of the FC/UPC connector is black, as shown in Figure D-4. 

2 Usage of FC/APC to FC/UPC Transfer Patch Cord 

If the FC/UPC fiber connector is selected, it can be connected to the FC/APC connector via the FC/APC to 

FC/UPC transfer Patch Cord, as shown in Figure D-5, FC/APC at one end and FC/UPC at the other end. 

 

Figure D-5 FC/APC to FC/UPC jumper 

In usage, the FC/APC connector of the fiber patch cord is connected to the BOTDR port of the 6419 distributed 

optical fiber strain tester while the FC/UPC connector joins the FC/UPC connector of the sensing optical fiber via 

the flange, as shown in Figure D-6. 
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Figure D-6 Jumper connection 

Usually, to prevent dust from polluting the flange interior, the two ends of the flange are protected with the 

protector when it is not in use, as shown in Figure D-7. 

 

Figure D-7 Flange configured with protectors 

To connect the flange to the optical fiber, first remove the protectors at both ends of the flange slowly and evenly. 

Keep hands from the flange interior to prevent pollution to the end face of the connected fiber. The flange without 

protectors are as shown in Figure D-8. 

 

Figure D-8 Flange without the protector 

After the protectors at both ends of the flange are removed, it can be seen that the flange has a nick on each end, 

as shown in Figure D-9. To connect the FC/UPC connector of the transfer patch cordto one end of the flange, first 

align the protrusion of the FC/UPC connector and the flange nick, as shown in Figure D-10. 

 

Figure D-9 Flange nick 

 

Figure D-10 Align FC/UPC connector protrusion and flange nick 

Then, slowly push the FC/UPC fiber connector into the flange connector. Keep your hands or other body parts 

from the ceramic core end face of the fiber connector to prevent pollution to the fiber end face. When the 

protrusion matches with the nick and pushing is unavailable, slowly tighten the connector fillet of screw to fix the 

FC/UPC connector to the flange, as shown in Figure D-11. 

 

Figure D-11 Fillet of screw of the FC/UPC connector connecting to the flange from one side 

As described in the preceding step, connect the FC/UPC connector of the sensing optical fiber to the other 
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connector of the flange. The flange connecting to the FC/UPC connector at both sides is as shown in Figure D-12. 

 

Figure D-12 Flange connecting to the FC/UPC connector at both sides 

3 Usage of FC/APC-FC/UPC Extension Patch Cord 

In the optical fiber test, if the FC/APC connector fails to be connected to the 6419 optical fiber connector due to 

insufficient length, the FC/APC-FC/APC extension patch cord is required. The FC/APC-FC/APC extension patch 

cord is as shown in Figure D-13, with the FC/APC connector at both ends. 

 

Figure D-13 FC/APC-FC/APC extension jumper 

In usage, one FC/APC connector of the fiber patch cord is connected to the BOTDR port of the 6419 distributed 

optical fiber strain tester while the other FC/APC connector joins the FC/APC connector of the sensing optical 

fiber via the flange, as shown in Figure D-14. For details about how to connect the optical fiber connector to the 

flange, see chapter 1 “FC/APC and FC/UPC Optical Fiber Connector” in Appendix D “Identification of FC/APC 

from FC/UPC and Jumper Connection.” 
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Figure D-14 Extension of the optical fiber jumper 
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Appendix E Maintenance and Cleaning of the Optical Output Port 

1 Maintenance of the Optical Output Port 

(1) Be sure to keep the optical output port clean. Once it is polluted, plenty of optical signals will lose, 

affecting the test. If it is polluted by dust for a long time, it will cause wear to the end face and result in permanent 

damage. Therefore, the optical output port needs to be cleaned regularly with anhydrous alcohol. 

(2) Be sure to clean the flange connector of the optical output port. If the flange connector is polluted, the test 

results will be affected. It may even pollute the fiber end face of the optical output port, affecting the test results 

and even causing permanent damage to the fiber end face. 

(3) After BOTDR and VFL optical ports are used, cover them with the dust-proof protective cover that also 

needs to be cleaned regularly. Keep them not in air for a long time to prevent the dust in the air from the fiber 

end face of the optical port; otherwise, the fiber end face may be polluted, causing wear to the end face and even 

permanent damage. In particular, in a working environment with heavy dust, frequent cleaning is more required. 

(4) If the fiber connector needs to be frequently pushed on to and pulled off from the BOTDR port, you are 

recommended to use the FC/APC-FC/APC patch cord as the extension cord. One end of the extension cord is 

connected to the BOTDR port while the other end is connected to the FC/APC connector of the sensing optical 

fiber via the flange, as shown in Figure E-1, to avoid damage to the optical port from frequent pushing on and 

pulling off the optical fiber connector, and even permanent damage. For details about how to use the FC/APC-

FC/APC extension patch cord, see section 3 “Usage of FC/APC-FC/APC Extension patch cord” in Appendix 

D “Identification of FC/APC from FC/UPC and patch cord Connection.” 
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Figure E-1 Protecting 6419 optical port with the fiber extension cord 

2 Cleaning of the Optical Output Port 

(1) Roles of cleaning the fiber connector and optical output port 

1. As the fiber core is very small, the dust and particulate matters attached to the fiber connector and optical 

output port may cover some part of the fiber core at the output port, deteriorating the instrument performance. 

2. The dust and particulate matters may cause damage to the end face of the fiber connector at the output port, 

thus deteriorating the accuracy and repeatability of the instrument. 

(2) Security principles to be followed before cleaning 

1. Ensure that the instrument is powered off before cleaning. 

2. Non-compliance with the regulated control, adjustment or operation steps may cause dangerous radiation 

injury. 

1. Ensure that the laser source is in the non-working state when any of the optical port is being cleaned. 

2. When the instrument is working, please do not look steadily at any optical output port to avoid damage to 

your eyes. 

(3) Tools used to clean the optical output port and connector 

3. You can use tools like the fiber cleaner or cleaning swab to clean the optical output port and connector. 

4. If the preceding professional tools are unavailable, please prepare the absorbent ball and anhydrous alcohol. 

(4) Steps for cleaning the optical output port and connector 

5. Power off the instrument. 

6. Entirely unscrew the flange nut. 

7. Gently pull out the flange, as shown in Figure E-2. 
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Figure E-2 Pulling out the flange 

8. Clean the end face of the optical output port and flange connector with the absorbent ball dipped in 

anhydrous alcohol. 

9. Gently wipe the end face of the optical output port with the professional lens paper. 

10. After cleaning, gently connect the flange nut to the optical output port and then screw the flange nut. 

(1) Pull out and connect the flange slowly and evenly without sudden force, thus avoiding 

damage to the end face of the optical output port. 

(2) Gently wipe the fiber end face to avoid damage to it. 

(3) During cleaning, keep the absorbent ball and anhydrous alcohol clean; otherwise, the fiber 

end face will be polluted, causing test inaccuracy. 

 

Caution! 

Flange plate 
cap 

End face of the 
optical output port 
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Appendix F Maintenance, Check, and Cleaning of the Fiber End Face 

1 Introduction to the Structure of the Fiber End Face 

An optical fiber is a kind of optical waveguide with a cylindrical cross section, made from silicon dioxide and a 

small amount of other materials. The guiding of light of the light-guide fiber is designed according to the light 

total reflection principle. The transmission of the light energy is confined in the fiber transmission interface so that 

the optical wave can be transmitted only in the fiber axial direction. 

Taking the standard fiber SMF-28e for example, it consists of a core surrounded by a cladding layer and coating 

layer. The fiber core is made from silica (glass) with a 9 um diameter; the cladding layer is made from silica with 

a 125um diameter; the coating layer is made from ceramics with a 0.9mm diameter. Figure F-1 shows the fiber 

axial cross section and figure F-2 shows the fiber radial cross section. 

 

 

Figure F-1 Fiber axial cross section 

 

 

Figure F-2 Fiber radial cross section 

2 Maintenance of the Fiber End Face 

Handle the fiber connector with care and hold the metal of the fiber connector, as shown in Figure F-3. Check 

whether the port type matches before inserting the fiber connector into the port. Mismatched port type will cause 

pollution or permanent damage to the fiber end face. Keep the fiber connector covered with a protector when it is 

not in use, avoiding pollution to the joint. 

 

Figure F-3 Metal of the fiber connector 

3 Check of the Fiber End Face 

In case of non-distinct Brillouin spectrum and non-obvious loss curve, the fiber end face may be polluted and then 

you need to check it. Figure F-4 shows the fiber end-face inspector required to check the fiber end face. It is an 

option of the 6419 distributed optical fiber strain tester, with the No. of 001. 
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Viewer Port of the 

fiber connector

 

Figure F-4 Fiber end-face inspector 

Step 1 Connect the fiber connector to the port on the bottom of the inspector, as shown in Figure F-5. This port 

supports the FC-APC and FC-UPC connectors. 

 

Figure F-5 Port position of the fiber connector 

Step 2 Put your eyes in the sight glass in the head of the inspector and keep your eyes close to the glass. 

 

Figure F-6 Position of the sight glass 

Step 3 Press and hold the power switch as shown in Figure F-7 and simultaneously rotate the spiral slowly to 

focus the inspector as shown in Figure F-8 until the clear end face can be seen. 

 

Figure F-7 Position of the power switch 

 

Figure F-8 Position of the spiral 
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Figure F-9 Image of a clear fiber connector 

As shown in Figure F-9, the optical fiber consists of the core, cladding layer, and ceramic core from the inside out. 

The fiber core ensures total internal reflection of light and transmits energy. Once it is polluted, light transmission 

is blocked, resulting in non-obvious loss curve and non-distinct Brillouin spectrum. Serious pollution can cause 

energy concentration and heating at the fiber end face, resulting in fiber connector burnt that is permanent damage. 

Fiber 

core

Cladding
Ceramic 

core

 

Figure F-10 Image of the fiber connector seriously polluted 

As shown in Figure F-10, a lot of gray contaminants gather on the fiber core and cladding layer. The ceramic core 

is attached with black contaminants. This condition is regarded as serious pollution and cleaning of the fiber end 

face is required. 

4 Cleaning of the Fiber End Face 

To clean the fiber end face, prepare the absorbent cotton (as shown in Figure F-11 (a)), alcohol (as shown in 

Figure F-11 (b)), and lens paper (as shown in Figure F-11 (c)). 

 

(A) Absorbent cotton     (b) Alcohol      (c) Lens paper 

Figure F-11 Tools required to clean the fiber end face 

Step 1 Wipe the fiber connector with the absorbent cotton dipped in the alcohol slowly and evenly, as shown in 

Figure F-12. 
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Figure F-12 Wipe the fiber connector with alcohol swab 

Step 2 Rub the fiber connector at the lens paper horizontally. Do not repeat rubbing the fiber connector at the lens 

paper used, avoiding secondary contamination to the fiber connector, as shown in Figure F-13. 

 

Figure F-13 Wipe the fiber connector with lens paper 

Step 3 Check the fiber end face with the fiber end-face inspector. If there are still foreign matters, continue to rub 

it. If the foreign matters cannot be removed after repeated rubbing, it is believed that the fiber connector is 

damaged and needs to be replaced. 
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Appendix G Check and Handling of Optical Fiber Break 

1 Check of Optical Fiber Break 

1.1 Check of Optical Fiber Break with BOTDR 

We can check whether the optical fiber breaks by measuring the fiber length. 

1.1.1 Method 1 

Step 1 Connect the fiber to the fiber port and set the appropriate range, pulse width, resolution, and refractive 

index. 

Step 2 Press  [Test] on the front panel and click Average to start the test. 

Step 3 Choose Multi > Loss, as shown in Figure G-1. 

 

Figure G-1 Multi window 

Step 4 In the Loss window, it can be seen that the loss curve drops in a certain area. Move the cursor to this area 

and press  on the front panel to zoom in this area. 

Step 5 Slowly rotate the knob on the front panel in a clockwise direction. It can be seen that the Brillouin 

spectrum gradually becomes non-distinct (as shown in Figure G-2) and disappears suddenly after a certain point 

as shown in Figure G-3. This point can be regarded as the fiber end, located at the distance of 24.59231 km. 

Step 6 Check whether the fiber breaks and the break position by comparing the nominal length and measured 

length of the fiber. If the nominal length equals the measured length, the fiber does not break; if the measured 

length is less than the nominal length, the fiber already breaks and the break takes place where the measured 

length is obtained. 

 

Figure G-2 Comprehensive loss curve of the fiber under test 
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Figure G-3 Brillouin spectrum disappears after crossing a certain point 

1.1.2 Method 2 

Step 1 Connect the fiber to the fiber port and set the appropriate range, pulse width, resolution, and refractive 

index. 

Step 2 Press [Test] on the front panel and click Average to start the test. 

Step 3 Choose Multi > BS. Width. In the BS. Width window, it can be seen that the loss curve drops in a certain 

area. Move the cursor to this area and press  on the front panel to zoom in this area. 

Step 4 Slowly rotate the knob on the front panel in a clockwise direction. It can be seen that the Brillouin 

spectrum gradually becomes non-distinct and disappears suddenly after a certain point as shown in Figure G-4. 

This point can be regarded as the fiber end, located at the distance of 24.64323km. 

 

Figure G-4 Loss curve of the fiber to be tested 

 

Figure G-5 Disappearing Brillouin spectrum after a certain point 
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Step 5 Check whether the fiber breaks and the break position by comparing the nominal length and measured 

length of the fiber. If the nominal length equals the measured length, the fiber does not break; if the measured 

length is less than the nominal length, the fiber already breaks and the break takes place where the measured 

length is obtained. 

1.2 Check of Optical Fiber Break and High-loss Point via VFL 

 

Figure G-6 VFL interface with protector 

The 6419 has a built-in visible red light fault location (VFL) function that can help determine where the fiber 

breaks and where the light energy leaks. 

Step 1 Connect the fiber to be tested to the VFL optical port on the front panel as shown in Figure G-6. For details 

about the connection, see section 8.1.2 “Connecting the Fiber.” 

Step 2 Select the [VFL] function button in the system sub-menu (or click the VFL
VFL

) button on the front panel) 

and the software will pop out the VFL control window. As shown in Figure G-7, it contains four options: OFF, 

CW, 1Hz, and 2Hz. The mouse or touch screen adjusts the working state of the VFL. 

  

Figure G-7 VFL Control dialog box 

Step 3 Set the VFL function in the VFL window according to the needs. Select the [CW] option, the instrument 

will output continuous visible red light in the VFL optical interface; select [1Hz] option, the instrument will output 

the visible red light with a frequency of 1Hz in the VFL optical interface; select [2Hz] option, the instrument will 

output the visible red light with a frequency of 2Hz in the VFL optical interface. 

Step 4 Check the optical fiber line and fiber end. If there is no red light at the fiber end but vast red light leaked at 

a certain point of the fiber line, check whether the fiber breaks at the leaking point, as shown in Figure G-8, or a 

small-radius bend appears as shown in Figure G-9. 

                  

              Figure G-8 Fiber with light leakage              Figure G-9 Fiber with a large bending radius 

Step 5 After the VFL function is used, set the VFL option to [OFF] in the VFL window to disable the VFL 
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function. 

Step 6 Remove the fiber under test from the VFL optical interface and cover the VFL optical interface protection 

cover. 

2 Handling of Optical Fiber Break 

The broken fiber needs to be spliced with the optical fiber fusion splicer. You are recommended to use the 

6471A multi-functional optical fiber fusion splicer manufactured by China Electronics Technology 

Instruments Co., Ltd (CETI). For details about the parameters and introduction, see section 1.2 “6471A 

Multi-functional Optical Fiber Fusion Splicer” in Appendix H “Recommended Optical Cable Laying, 

Maintenance, and Testing Tools.” For details about the splicing procedures, see the User Manual of 6471A 

Multi-functional Optical Fiber Fusion Splicer. 

After splicing, measure the fiber length by referring to section 1.1 “Check of Optical Fiber Break with BOTDR” 

in Appendix G “Check and Handling of Optical Fiber Break.” If the measured fiber length equals the nominal 

length, it proves that splicing is good. Alternatively, test the fiber by referring to section 1.2 “Check of Optical 

Fiber Break and High-loss Point via VFL” in Appendix G “Check and Handling of Optical Fiber Break.” If there 

is no red light leakage at the splicing point, it proves that splicing is good. 
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Appendix H Recommended Tools for Cable Laying, Maintenance and Testing 

1 6416/6418 Optical Time Domain Reflectometer 

 

Figure H-1 6416/6418 high-performance multi-functional optical time domain reflectometer 

The 6416/6418 optical time domain reflectometer is mainly used to measure the physical characteristics of optical 

fiber & cables, including length, transmission loss, and splice loss. It can also accurately locate the event point and 

fault point along the optical fiber. It is widely used in fiber optic communications, engineering construction, 

maintenance test, and urgent repairing of the optical fiber sensing system, as well as the R&D, manufacturing, and 

test of the optical fiber and cables. 

Main Features: 

1. Single-ended non-destructive testing; 

2. Most advanced technology of double color and two materials integrative mold design process, strong and 

firm; 

3. Advanced anti-reflection LCD display providing a quite clear operation interface even in field environment; 

4. Multiple testing modes, touch screen and keyboard operation; 

5. Automatic detection of the communication light; 

6. Two USB interfaces allowing connecting externally to a USB flash drive and printer, and communicating 

with a PC via the SyncActive software; 

7. Supporting Bellcore GR196 and SR-4731 file formats; 

8. Battery low-voltage alarm; 

9. Built-in the VFL function and optical power meter (only 6418); 

10. Exchangeable OTDR optical output connector, more convenient for surface cleaning; 

11. On-line upgrading of application software, no need to return back to the manufacturer. 

Technical Specifications: 

 6416 6418 

Dynamic range 28dB to 35dB 35dB to 45dB 

Ranging accuracy ± (0.75m + Sampling spacing + 0.0025% × Distance)(excluding refractive index placement 

error) 

Highest ranging resolution 0.125m 0.05m 

Test range 0.5km to 256km (single-mode) 

0.5km to 32km (850nm multimode) 

0.4km to 512km (single-mode) 

0.4km to 32km (850nm multimode) 

Test pulse width 10ns to 10,240ns (single-mode) 

10ns to 1,280nm (multimode) 

5ns to 20,480ns (single-mode) 

5ns to 1,280nm (multimode) 

Number of sampling 

points 
128k 256k 

Linearity 0.05dB/dB 

Refractive index setting 

range 

1.00000 to 2.00000 (step 0.00001) 
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VFL 650nm ± 10nm, 2mW (typical), CW/1Hz 

Optical power meter None Wavelength range: 1,200nm to 1,650nm 

Power range: -60dBm to 0dBm 

Test uncertainty: ± 5% (-25dBm, CW) 

Optical output port FC/UPC (can be changed to ST/UPC or SC/UPC) 

External interface USB or Min-USB USB, Min-USB, Ethernet, headset, and SD 

Power supply AC/DC adapter: AC 100V to 240V, 50/60Hz, 1.5A 

DC: 19V ± 2V (2A) 

Built-in lithium battery: Working hours: 8 hours (normal temperature) 

Maximum power 

consumption 

5W 10W 

Dimension (width x height 

x depth) 
210mm × 100mm × 60mm 186mm × 295mm × 75mm 

Weight About 0.9kg About 2.2kg 

 

Environmental adaptability 

Operating temperature: -5℃ to 50℃ (battery charging: 5℃ to 40℃) 

Storage temperature: -40℃ to 70℃ (battery: -20℃ to 60℃) 

Relative humidity: 5% to 95% (noncondensing) 

2 6471A Multi-functional Optical Fiber Fusion Splicer 

 

Figure H-2 6471A multi-functional optical fiber fusion splicer 

The 6471A multi-functional optical fiber fusion splicer is a newly designed optical fiber fusion splicer. It is 

specifically used for fiber splicing under the FTTH environment. With compact structure and exquisite design, it 

is easy to operate even in confined space. The optical imaging system and full-digital design make the image 

display clear and exquisite. The embedded real-time operating system provides friendly operation interface and 

multiple functions. The built-in high capacity lithium battery guarantees long-time field operation. The 

temperature and air pressure real-time compensation system greatly improves the ability against the hostile 

external environment, , and thus ensures the consistency of low-loss splicing in different environments. 

Main Features: 

12. Precise alignment of fiber cores to ensure the low-loss splicing. 

13. Small size and light weight with only 2.8kg including the battery. 

14. Nine-second splicing and 30-second heat shrink. 

15. Simultaneous display of the x-axis and y-axis, 304 times of magnification. 

16. Can be set to automatically start splicing once closing the windshield, and automatically start 

pyrocondensation once closing the heating cover. 

17. Real-time discharging correction, no need to adjust the parameters. 
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18. Long lifetime of electrode, discharging up to 4,000 times. 

19. USB and VGA port. 

20. Built-in high capability lithium battery, supporting 220 splicings and heatings. 

21. Real-time accurate display of remaining battery capability. 

22. Automatic software upgrading via the USB flash drive. 

Technical Specifications: 

Optical fiber type SM (single-mode), MM (multi-mode), DS (dispersion shifted), and NZDS (dispersion 

unshifted) 

Splicing loss 0.02dB (SM), 0.01dB (MM), 0.04dB (DS), and 0.04dB (NZDS) 

Return loss Better than 60dB 

Operation mode Full-automatic, semi-automatic, and manual 

Fiber alignment Advanced PAS aligning 

Applicable fibers Terminal flexible optical cable, SC or FC connector (optional), and 0.25mm or 0.9mm ordinary 

optical cable 

Cleave length 8mm to 16mm 

Magnification 304/152 times 

Image display High-performance 5.7-inch LCD providing clear and exquisite image display 

Tension test Standard 2N (optional) 

Heat shrink tubing 60mm, 40mm, and a series of heat shrink tubing 

Battery capacity Typical 220 splices, charging about 3.5 hours (available during charging) 

Electrode life Cycle charging up to 300 to 500 times, can be replaced by the user 

Construction lighting Built-in high-brightness and wide-range lamp, greatly facilitating night operations 

Power supply Built-in lithium battery 11.1V; external adapter; input: AC 100 to 240V; output: DC 13.5V/4.5A 

Working environment Temperature: -10 to +50℃; humidity: 95% RH (40℃, noncondensing); altitude: 0 to 5000m 

Weight 2.3kg (without battery); 2.8kg (with battery) 

Operation interface Chinese/English 

Dimensions (width x 

height x depth) 

160mm*150mm*140mm 

Maximum power ≤ 20W (without charging); ≤ 55W (with charging) 

DC internal power Service time (23℃ ± 2℃) ≥4h (continuous operation); ≥10h (standby) 

Charging time ≤ 3.5h (power-off): ≤ 4.5h (power-on) 

DC external power 

(external power 

adapter) 

Input 100V to 240V, 50/60Hz 

Output 13V to 14V, ≥ 4.4A, power plug center as the positive pole 

Leakage current 220V input voltage, leakage current ≤ 3.5mA 

 


